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© Cypress Semiconductor Corporation, 2011-2013. The information contained herein is subject to change without notice.
Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a
Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted
nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an
express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components
in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user.
The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such
use and in doing so indemnifies Cypress against all charges.

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by
and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty
provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create
derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom soft-
ware and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as speci-
fied in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source
Code except as specified above is prohibited without the express written permission of Cypress.

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATE-
RIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described
herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein.
Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure
may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support sys-
tems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all
charges.

Use may be limited by and subject to the applicable Cypress software license agreement.

PSoC Creator is a trademark and PSoC and CapSense are registered trademarks of Cypress Semiconductor Corp. All other
trademarks or registered trademarks referenced herein are property of the respective corporations.

Flash Code Protection

Cypress products meet the specifications contained in their particular Cypress PSoC Datasheets. Cypress believes that its
family of PSoC products is one of the most secure families of its kind on the market today, regardless of how they are used.
There may be methods, unknown to Cypress, that can breach the code protection features. Any of these methods, to our
knowledge, would be dishonest and possibly illegal. Neither Cypress nor any other semiconductor manufacturer can guaran-
tee the security of their code. Code protection does not mean that we are guaranteeing the product as ‘unbreakable’.

Cypress is willing to work with the customer who is concerned about the integrity of their code. Code protection is constantly
evolving. We at Cypress are committed to continuously improving the code protection features of our products.
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Regulatory Compliance

The CY8CKIT-025 is intended for use as a development platform for hardware or software in a
laboratory environment. The board is an open system design, which does not include a shielded
enclosure. This may cause interference to other electrical or electronic devices in close proximity.

In a domestic environment, this product may cause radio interference. In this case, you may be
required to take adequate prevention measures. Also, the board should not be used near any
medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-025 as shipped from the factory has been verified to meet with requirements of CE as

a Class A product.
and any equipment, and can discharge without detection. Permanent

damage may occur on devices subjected to high-energy discharges.

\ Proper ESD precautions are recommended to avoid performance
degradation or loss of functionality. Store unused CY8CKIT-025 boards

in the protective shipping package.

The CYB8CKIT-025 contains electrostatic discharge (ESD) sensitive
devices. Electrostatic charges readily accumulate on the human body

End-of-Life/Product Recycling

This kit has an end-of-life cycle five years from the date of manufacturing
mentioned on the back of the box. Contact your nearest recycler for
discarding the kit.

CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board Kit Guide, Doc. # 001-65791 Rev. *G 5
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General Safety Instructions

Electrostatic Discharge Protection

ESD can damage boards and associated components. Cypress recommends that you perform
procedures only at an ESD workstation. If one is not available, use appropriate ESD protection by
wearing an antistatic wrist strap attached to chassis ground (any unpainted metal surface) on your
board when handling parts.

Handling Boards

CY8CKIT-025 boards are sensitive to ESD. Hold the board only by its edges. After removing the
board from its box, place it on a grounded, static free surface. Use a conductive foam pad if
available. Do not slide board over any surface.
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Thank you for your interest in PSoC solutions for temperature sensing. The CY8CKIT-025 PSoC®
Precision Analog Temperature Sensor Expansion Board Kit (EBK) together with the example
projects provide complete solutions demonstrating PSoC-based temperature sensing. The
CY8CKIT-025 board connects with the CY8CKIT-030 PSoC 3 Development Kit (DVK), CY8CKIT-
050 PSoC 5LP Development Kit, or the CY8CKIT-001 PSoC Development Kit. The kit supports
temperature measurement using four temperature sensors:

m Thermocouple

m Thermistor

m Resistive Temperature Detector (RTD)
m Diode

Note: The TempSense example project outputs one more temperature value read from the DS600
IC. This is used for cold junction compensation for the thermocouple and not intended as an option
for the onboard temperature sensor.

The four sensors have their own advantages and limitations. The choice of a sensor for an
application depends on the cost, accuracy required, and temperature measurement range.

Thermocouples measure temperatures in a wide range, from —250 °C to 2300 °C. However, the
voltage change is not linear and takes more CPU cycles for temperature computation.
Thermocouples require another temperature sensor, such as the thermistor, diode, or RTD, to
measure the cold junction temperature. The DS600 IC or the thermistor can be used for cold junction
compensation of the thermocouple. A thermistor, diode, or RTD cannot measure temperatures
greater than 850 °C. Thermocouples have a very good response time.

Thermistors have a highly nonlinear curve and take more CPU cycles for temperature computation.
They measure temperature in the range —100 °C to 200 °C. Thermistors have a good response time
and they are less expensive when compared to RTDs and thermocouples.

RTDs have a linear and repeatable resistance variation with temperature, making it easier to
compute temperature accurately. They measure temperature from —200 °C to 850 °C. RTDs are
expensive due to their linearity and accuracy. RTDs have a lower response time compared to a
thermistor or thermocouple.

Diodes are the cheapest sensors for temperature measurement. They measure temperature in the
range —50 °C to 150 °C. Accurate temperature measurement is difficult with a diode. Table 1-1
shows a comparison among the four sensors.

CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board Kit Guide, Doc. # 001-65791 Rev. *G 7



Introduction

=94 CYPRESS

Table 1-1. Temperature Sensor Comparison

Parameter RTD Thermocouple Thermistor Diode
(TfC”;perat”re range 1 _200 to +850 ~250 to +2350 ~100 to +300 50 to +150
Sensitivity at 25 °C |0.387 Q/°C 40 pV/°C (K-type) 416 Q/°C 250 pv /°C
Accuracy High Medium to High Medium Low
Linearity Good Fair Poor Good
Typical cost (US $) [$3-$80 $3-$15 $0.2-$10 <$0.2

Surface mount for
onboard temperature.
3- and 4-wire up to a
few hundred meters

Surface mount for
onboard temperature.
Leaded for <1 meter

Onboard temper-
ature

Typical distance of

. <100 meters
sensing

Amplifier, ADC, volt-
age reference, and
another temperature

Excitation cur-
rent, amplifier,

Excitation current,
ADC, reference resis-

Excitation current,

Resource require- amplifier, ADC, refer-

ment ence resistor sensor for cold junc- |tor ADC

tion
Response time Slow Fast Fast Slow
Computational
complexity (best High Very high Very high Medium
possible accuracy)
Cypress applica- | \\ 70598 AN75511 ANG6477 ANB0590

tion note

Note: The temperature sensor comparison chart does not include values for DS600 IC because it is
used for cold junction compensation for the thermocouple; it is not intended for use as an onboard
temperature sensor.

This kit includes three example projects, divided into project areas based on end applications. Each
project area contains examples for the CYB8CKIT-030, CY8CKIT-050, and CY8CKIT-001
development kits. The CY8CKIT-030 DVK contains a PSoC 3 (8051 core) and the CY8CKIT-050
DVK contains a PSoC 5LP (ARM Cortex-M3); both support high-performance analog applications.

The CY8CKIT-001 DVK can be used to develop solutions for PSoC 1 (M8C proprietary core),
PSoC 3, or PSoC 5LP (ARM Cortex 3). The included example projects support PSoC 3 (8051) and
PSoC 5LP (ARM Cortex-M3).

The Tempsense example project provided with the kit supports most temperature sensing
applications. It provides a high-performance temperature sensing example by using the ADC in 20-
bit mode and implementing a high-precision linearization algorithm. It includes a resistance
temperature detector (RTD), thermocouple, thermistor, two temperature diodes, and an IC
temperature sensor. You can evaluate and compare sensor performance. Complete interface and
output signal correction solutions can be developed for each type of temperature sensor. With the
20-bit ADC of the PSoC, it is possible to obtain a 0.1-°C resolution easily with all four sensors. The
accuracy varies in each case depending on the method of measurement and the sensor used. See
the Hardware chapter on page 25 for details.

The Sequenced ADC example project includes three temperatures (RTD, temperature diode, and IC
temperature sensor) as well as millivolt and voltage inputs. This project can be used for sensing
applications that require temperature measurement (such as RTD) as well as other types of voltage
output sensors. It can also be used for system monitoring applications requiring temperature (usually

8 CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board Kit Guide, Doc. # 001-65791 Rev. *G
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temperature diode or IC temperature sensor) and voltage rail measurement. The sequenced ADC
example project uses the ADC in 16-bit mode and provides a higher throughput. In this project, the
ADC readings are automatically repeated at consistent intervals, which allow filtering of ADC
readings to remove specific frequencies of interest, such as a 50- and 60-Hz hum.

The Thermal Management System example project supports fan control applications. Add the
CY8CKIT-036 EBK (with two four-wire fans) to the CY8CKIT-025 EBK and a development kit to
support complete temperature-based fan control solutions. For more details on CY8CKIT-036 PSoC
Thermal Management EBK, see the Cypress website.

1.1 Kit Contents

The CY8CKIT-025 PSoC Precision Analog Temperature Sensor EBK includes:
CYB8CKIT-025 PSoC Precision Analog Temperature Sensor Board

Two CY8CKIT-012 prototype boards

Omega thermocouple K-type 5srtc-gg-20-36

Two 2N3904 NPN transistors

Two prototype headers for CY8CKIT-012 prototype board

Quick start guide

Resource CD

Wires

Mini Philips cross screw driver (black)

CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board Kit Guide, Doc. # 001-65791 Rev. *G 9
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Figure 1-1. CY8CKIT-025 Kit Contents

Quick Start
Kit OVD — ke
Omega —_—
Thermacouple K-type CYBCKIT-012
= Protolype
Boards

Wires

w/ |_,_. 4 ? Q

2_':_‘390‘_1 r‘PN Prototype Headers for
ransistors
CYBCKIT-012 Board g driver

Thermocouple Section

2x20 Pin
. L Connector for
Dloc_ie Development Kit
Section Interface
Thermistor Section RTD Section
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1.2

1.3

1.4

1.4.1

1.4.2

1.4.3

Introduction

PSoC Creator™

Cypress's PSoC Creator software is a state-of-the-art, easy-to-use integrated development
environment (IDE) that introduces a hardware and software design environment based on classic
schematic entry and revolutionary embedded design methodology.

With PSoC Creator, you can:

m Automatically place and route select components and integrate simple glue logic normally
located in discrete muxes.

m Trade off hardware and software design considerations, allowing you to focus on what matters
and getting to market faster.

PSoC Creator also enables you to tap into an entire tools ecosystem with integrated compiler tool
chains, RTOS solutions, and production programmers to support both PSoC 3 and PSoC 5LP
devices.

Getting Started

Follow the steps in the Software Installation chapter on page 15 to install the kit. See the Kit
Operation chapter on page 19 and Hardware chapter on page 25 to understand the kit operation and
hardware. The Example Projects chapter on page 31 explains the details of the firmware and
provides steps to run the projects.

Additional Learning Resources

Visit http://www.cypress.com/go/psoc3 for additional learning resources in the form of datasheets,
technical reference manual, and application notes.

Beginner Resources

AN54181 - PSoC 3 - Getting Started with a PSoC 3 Design Project

PSoC Creator Training

Engineers Looking for More

AN54460 - PSoC® 3, PSoC 4, and PSoC 5LP Interrupts

AN52705 - PSoC® 3 and PSoC 5LP - Getting Started with DMA

AN52701 - PSoC® 3 and PSoC 5LP - Getting Started with CAN (Controller Area Network)
AN54439 - PSoC® 3 and PSoC 5LP External Crystal Oscillators

AN52927 - PSoC® 3 and PSoC 5LP: Segment LCD Direct Drive

Cypress continually strives to provide the best support. Click here to view a growing list of
application notes for PSoC 3 and PSoC 5LP.

Learn from Peers

Cypress Developer Community Forums

CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board Kit Guide, Doc. # 001-65791 Rev. *G 11
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144 More Code Examples

PSoC Creator provides several example projects that make code development fast and easy. To
access these example projects, click Find Example Project... under the Example and Kits section
in the Start Page of PSoC Creator or navigate to File > Open > Example Project....

Figure 1-2. Find Example Project

//-.St,artpagel File | Edit Wiew Debug Project Buld Tools  Window He
[t 3 3 [, X i
PSoC® Creator™ | open M 53 prosctporkspace
5 File... Ctrl+0
= Clase Crrl4+F4 | Example Project...
Recent Projects

Create New Project...
Open Existing Project ...

Getting Started
PSoC Creator Start Page
Quick Start Guide
Intro to PSoC
Intro to PSoC Creator
PSelC Creator Training
Design Tutorials
Getting Started With PSoC 3
Getting Started With PSoC 4
Getting Started With PSoC 5LP

m

Examples and Kits

Find Example Project...
= Kis

The Find Example Project section has various filters that help you locate the most relevant project.
PSoC Creator provides several starter designs. These designs highlight features that are unique to
PSoC devices. They allow you to create a design with various components, instead of creating a
new empty design; code is also provided. To use a starter design for your project, navigate to File >
New > Project and select the design required.

12 CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board Kit Guide, Doc. # 001-65791 Rev. *G
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Figure 1-3. New Project

r ~
MNew Project g u_J@ e
Design ] Other 4
= Empty Templates o
J Empty PSoC 2 Design Creates a PSoC 3, & bit, design project.
J Empty PSoC 4 Design Creates a PSoC 4, 22 bit, design project.
J Empty PSoC 5LP Design Creates a PSoC BLP, 32 bit, design project. L
[ PSoC 3 Starter Designs 1
5‘ ADC_DMA_VDAC Shows how to transfer data from an ADC to a DAC using DMA with ne CPU intervention.
. Shows & 16-channel, 12-bit Delta Slgma ADC in PSoC 3 sequenced in hardware; samples are
5‘ DelSig_16Channel transferred from ADC to SRAM using DMA - without processor intervention
5‘ DelSig_I2CM ggms the 16-bit differential ADC, multiplexed into 8 chi |5 &nd transported over
5‘ DelSig_I2CS ggms the 16-bit differential ADC, hard multiplexed into 8 chy |s and transported over
5‘ DelSig_SPIM gg?ws the 16-bit differential ADC, hard multiplexed into 8 chy |s and transported over
i .
E‘ Filter ADC_VDAC Shows how to filter an analeg input all in hardware, and provides all the DMA setup to transfer the

data from the ADC directly to the Digital Filter Block, bypassing the processor
5‘ Hl_Fan_Centrol_with_&lert Shows how performing fan control in hardware completely frees up the CPU.
= PSoC 4 Starter Designs

Mame: Design01
Location: C:\Program Files"Cypress D
Advanced

[ ok || comcs |

The starter designs and the example project contain a PDF within the project that explains the fea-
tures of the project and its configuration.

Figure 1-4. Project PDF Location

Wrkspace Explorer -~ 0 X
i
B3] workspace Helldwiorld_Blinky01' (1 Projects)
= EI Project "Hellow'orld_Blinkyp01* [CY8C3066A-1-040]
Iﬂ' TopDesign.cyach
jg Hedlovarld_Blink 01 . cydwr
=1 Header Files

g

] device.h E

=M Source Files %
H ou]

] main.c =

|1 Helicteiord Blinky.pdf |

Note: The example projects and starter designs are designed for CY8CKIT-001 PSoC Development
Kit. However, these projects can be converted for use with CY8CKIT-030 PSoC 3 Development Kit
or CY8CKIT-050 PSoC 5LP Development Kit by following the procedure in the knowledge base arti-
cle Migrating CY8CKIT-001 DVK project to CY8CKIT 030/ 050.

Apart from the example projects and starter designs that are available within PSoC Creator, Cypress
continuously strives to provide the best support. Click here to view a growing list of application notes
for PSoC 3, PSoC 4, and PSoC 5LP.

145 Technical Support

For assistance, go to http://www.cypress.com/go/support or contact our customer support at
+1(800) 541-4736 Ext. 8 (in the USA), or +1 (408) 943-2600 Ext. 8 (International).

CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board Kit Guide, Doc. # 001-65791 Rev. *G 13
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1.5 Document History
. PDF Creation Origin of o
Revision Date Change Description of Change
> 04/11/11 PFZ Initial version of kit guide.
*A 11/29/11 SASH Updated PSoC Creator version.
*B 03/24/12 RKAD Updated existing project; added two new projects.
*C 06/07/12 PFZ Updates to Aqdltlonal Resources section. Updated images in the
Example Projects chapter.
*D 09/07/12 PFz Document changes to reflect support for PSoC5
. Added the Safety section. Updated images in the Code Exam-
E 03/28/13 VRNK ples chapter. Minor updates throughout the document.
. Updated CY8CKIT-001 PSoC DVK Thermistor Temperature on
F 04/26/13 VRNK page 40 and CY8CKIT-030 PSoC DVK on page 53.
*G 09/12/13 SASH Updated images for PSoC Creator ECR. Added section 5.1.1
1.6 Document Conventions

Table 1-2. Document Conventions for Guides

Convention Usage

Displays file locations, user entered text, and source code:
C:\ ...cd\icc\

Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

Courier New

Italics

Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

Represents menu paths:
File > Open > New Project

[Bracketed, Bold]

File > Open

Displays commands, menu paths, and icon names in procedures:

Bold Click the File icon and then click Open.

Displays an equation:
2+2=4

Text in gray boxes Describes cautions or unique functionality of the product.

Times New Roman

14 CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board Kit Guide, Doc. # 001-65791 Rev. *G
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The kit CD/DVD contains the PSoC Precision Analog EBK-related software. The installer in the CD/
DVD checks if the prerequisites — PSoC Creator, PSoC Programmer, Windows Installer,
Windows .NET, and Keil C51 compiler, are installed in your PC. If these applications are not
installed, then it installs them before installing the kit. If the Acrobat Reader application is not
installed in your PC, then the installer provides the link to install the same; this does not prevent kit
installation. Note that Adobe Reader is required to view the kit documents. The installer also installs
the example projects, user guide, quick start guide, and other kit-related documents as part of kit

installation.

The installation steps are as follows:

1. Insert the kit CD/DVD into the CD/DVD drive of your computer. The CD/DVD is designed to auto-
matically open an installation dialog (see Figure 2-2). Note: If auto-run does not execute, double-

click cyautorun.exe in the root directory of the CD/DVD.

Figure 2-1. CD/DVD Root Directory

Marre
Files Currently on the CD

CIDocumentation
CFrmware
CHardware
CPTerequisite
CIPSoC Creator
CIPS0C Preciion Anaog EBK
CIPSOC Programmer
% autorun.nf

B cyautorundat

& Cyautorun exe

& setupico

Size

1KB

1418 KB
10 KE

Type

Fle Folder

Fia Foider

Fhe Fesder

Fie Fokder

Fie Foider

Fie Feider

Fhe Folder

Setup Information
Friobe Document
Apphcation

leon

2. The CD/DVD installation dialog prompts you to open this file or begin installing the development
environment software. Click the Install PSoC Precision Analog EBK button to begin installation.
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Figure 2-2. PSoC Precision Analog EBK Window
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PSoC Precision Analog EBK

Open the Kit User's Guide...
Install PSoC Precision Analog EBK. ..

Exit

Semiconductor Corporation. All rights reserved

3. Choose the Typical installation type in the Product Installation Overview window.

PSoC Creator uses the DP8051 Keil 9.51 compiler to build PSoC 3 applications. This compiler is
included on the CD/DVD; the installer will prompt you to install the compiler if it is not detected.

Note: The Keil compiler is distributed with a free license. You must activate this license within 30
days of installation. When the Cypress software installation is complete and you run PSoC Creator,
activate the compiler license from Help > Register > Keil.

Note: If there is a problem with Keil registration, rename the *_tools.ini file in
<Install_Directory>\PSoC Creator\<version>\PSoC Creator\import\kei I\pk51\
<version> to "tools.ini" for the Keil registration to be successful.
After the installation is complete, the following are installed in your computer:
m PSoC Creator 3.0 or later
m PSoC Programmer 3.19.1 or later
m Kit documents:

o Quick Start Guide

o User Guide

a Temperature Sensor Datasheets
m Firmware

o Example Projects
m Hardware

o Schematic

o Layout

a Bill of Materials (BOM)
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If you have PSoC Creator and PSoC Programmer already installed in your computer, the installer
will install only the kit-related files in <Install_Directory>\PSoC Precision Analog EBK\
<version>, as shown in Figure 2-3.

Figure 2-3. Installed Files

Ko\ )= » Computer » Windows7_0S (C) » Program Files () » Cypress » PSoC Precision Analog EBK » 20 <[ é3 || search 20
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8 Downloads
s o kit_documentation @:) tinfo
Zl Recent Places F“"Efuldﬂ @ | Chrome HTML Document =" | XML Document
e = a6bytes
i Libraries
%] Documents
& Music
|5 Pictures

B videos

™ Computer L4
&, Windows7_0S (C
2} Lenovo Recoven
S installable (\\ma ~

7 items

After installation, launch the example projects associated with the kit from the PSoC Creator Start
Page, as shown in Figure 2-4.

Figure 2-4. PSoC Creator Start Page
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Ooan Banting Project Tree Cpenss FEod P o Sensor you to measun i with 2 0.1°C resclution wit four
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g PSoC Crectr St Poge o CERCKITO% PSOC Procision Angh
uick St G This guid pravides detail mbormation 5 SaC Py Aol o Daard K
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i e . » CISCKIT025 Plog Brecision & e "
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(g Stamec W Fac wF To access design fles and 25 PSIC Analog L
Lramples and Kils please rowss the kit CO,
find Exampie Progect
s 0
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Y SecuencedADC_001 cywrkc
Y SecumrcedADC_020_ 0501
Bl TempSanse 01 cywic
I5Y TempSense_030_ 050 cywsc
) Thomemial Mamangemmert 5
IE1) Thasmal Managemant Syt
Cutput -
Show cutput fram: A1l B
Log file for thia = ia lecated at: Ci\Uaers\sash\Applata'\local\Tesp\P2eC Creator-000.1eg
= | Oulpt e Lint

Ready

CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board Kit Guide, Doc. # 001-65791 Rev. *G 17



==77 CYPRESS

PERFORM

Software Installation

18 CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board Kit Guide, Doc. # 001-65791 Rev. *G



3. Kit Operation

e _ N
e,

=4 CYPRESS

PERFORM

3.1 Kit Overview

Figure 3-1 shows the CY8CKIT-025 PSoC Precision Analog Temperature Sensor EBK. The circuits
associated with each sensor are boxed and labeled in the figure. The kit has an RTD, a thermistor,
and a DS600 IC sensor onboard and provides interface slots to plug in your thermocouple, diode,
thermistor, or external RTD. The kit includes two diodes and a K-type thermocouple.

Figure 3-1. CY8CKIT-025 PSoC Precision Analog Temperature Sensor EBK

Thermogcouple Section

sV
RSVD
"v'S'n N1 3av i [N RN

VOO P9 P12_3

DICOE  INPUT CYBCKIT-025 PSeC
i PRECISION ANALOG

— 2X20 Pin Connector
HME E E'] “TPS — for Development Kit

f : 1 Hd
Diode e i Interface
Section : = -

Thermistor Section

RTD Section

3.2 Kit Connections

The CY8CKIT-025 EBK connects to a development kit (DVK) using a 2x20 pin connector. You can
use the CY8CKIT-030 PSoC 3 DVK, CY8CKIT-050 PSoC 5LP DVK, or CY8CKIT-001 PSoC DVK.
The CY8CKIT-025 EBK can be connected to port E of the CY8CKIT-030 PSoC 3 DVK (see
Figure 3-2) or port E of the CY8CKIT-050 PSoC 5LP DVK (see Figure 3-3), or port A of the

CY8CKIT-001 PSoC DVK (see Figure 3-4).
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Figure 3-2. Connect 2x20 Pin Connector to Port E of CYS8CKIT-030 PSoC 3 DVK
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Figure 3-3. Connect 2x20 Pin Connector to Port E of CYS8CKIT-050 PSoC 5LP DVK
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WARNING: Static discharges from the human body can easily reach very high voltages in the order
of kV. Such voltages can damage the PSoC device on the development kit. Ensure that you dis-
charge any static before touching the hardware. Follow these steps to avoid any unwanted behavior
on the board:

1. Power off the kit before making any connections
2. Connect the CY8CKIT-025 EBK to the development kit being used
3. Power on the development kit

3.3 Temperature Sensors

The PSoC Precision Analog Temperature Sensor EBK supports the following temperature sensors:
m Thermocouple

Thermistor

Resistive Temperature Detector (RTD)

Diode

DS600 IC

3.3.1 Thermocouple

The board has a K-type thermocouple socket, PCC-SMP-K-5. The K-type Omega thermocouple,
5SRTC-GG-K-20-36, is shipped with the kit. It complies with the ASTM special limits of error toler-
ance standard. IC DS600 is provided on the board for cold junction compensation. The thermistor on
the board can also be used for cold junction compensation. Because the onboard thermistor is not
calibrated, the IC (DS600) is provided for cold junction compensation. AN75511 - Temperature Mea-
surement with Thermocouples provides an example project that demonstrates how to use the therm-
istor for cold junction compensation. For more details about the thermocouple 5SRTC-GG-K-20-36
and IC DS600, see their datasheets in the following location:

<Install_Directory>\PSoC Precision Analog EBK\<version>\Documentation\DataSheet.

While connecting the thermocouple to the connector, make sure the markings in the thermocouple
match those of the connector.

Figure 3-5. Thermocouple

3.3.2 Thermistor

The board has a NCP18XH103FO3RB (NTC) thermistor. It has a 1 percent tolerance (10 k + 1%) at
25 °C. For more details about the sensor, see its datasheet in the following location:
<Install_Directory>\PSoC Precision Analog EBK\<version>\Documentation\DataSheet

You can also plug an external thermistor in terminal J7. The choice between using the internal and
external thermistor is made using jumper J5. The jumper is inserted on header position 1-2 for using
an external thermistor and on header position 2—3 for using the internal (onboard) thermistor. The
silk indicates the jumper positions for internal and external thermistors.
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Figure 3-6. Thermistor
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Platinum RTD PTS080501B100RP100, which is a class B PT-100 RTD, is used on the board. See
the RTD datasheet in the following location for more details:
<Install_Directory>\PSoC Precision Analog EBK\<version>\Documentation\DataSheet.

You can connect any external four-wire RTD. Follow these instructions to use the internal and

external RTDs.

m External RTD: Connect the external RTD to terminal blocks J8 and J9. The silk helps in the con-
nection. Remove jumper J6.

m Internal (onboard) RTD: Place jumper J6. On jumper J8, short 1-2 and 3—4. Figure 3-7 shows the
connections for an internal RTD.

Figure 3-7. RTD
RTD1 RTD

i I3

Jé 1

P6
== INT. ® EI

J8 EXTERNAL RTD J9 R10

B

v,

Diode

Terminal block J4 provides the option to connect up to two diode connected transistors. The diodes
are connected anti-parallel (see Figure 4-4 on page 30) to each other so that two temperatures are
measured with just four pins — two pins to pass current and two pins to measure Vgg.

J4 (1-4) is used to connect transistor 1. Connect the collector, base, and emitter to screws J4 1, 2,
and 3, respectively. Use a small wire to short J4, 3—4. This is to support four-wire measurement so
that the series resistance error can be avoided. See the Diode section on page 29 for details. This
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wire also shorts the base and collector of transistor 2.

If you are installing only transistor 1, make sure you also have a wire between J4, 7-8 so that the
base and collector of transistor 1 are shorted. Alternatively, you can short the base and collector
directly on the transistor, as shown in Figure 3-8.

J4 (4-8) is used to connect transistor 2. Connect the collector, base, and emitter to screws J4 5, 6,
and 7, respectively. Use a small wire to short J4, 7-8. This is to support four-wire measurement so
that the series resistance error can be avoided. See the Diode section on page 29 for details. This
wire also shorts the base and collector of transistor 1.

If you are installing only transistor 2, make sure you also have a wire between J4, 3—4 so that the
base and collector of transistor 2 are shorted. Alternatively, you can short the base and collector
directly on the transistor, as shown in Figure 3-8.

The 2N3904 transistor is shipped with the kit. See the datasheet in the following location for details:
<Install_Directory>\PSoC Precision Analog EBK\<version>\Documentation\DataSheet.

Figure 3-8. Diode

3.4 Prototype Boards
The kit includes two CY8CKIT-012 prototype boards. The prototype boards plugs into any port of

DVKs, CY8CKIT-001, CY8CKIT-030, and CY8CKIT-050 and they can be used for prototyping your
custom circuit built around PSoC.
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4.1 System Block Diagram and Theory of System Operation

The schematic of the CY8CKIT-025 PSoC Precision Analog Temperature Sensor EBK is shown in
the Appendix on page 83. The circuits associated with each temperature sensor are boxed
individually. This section gives a description of each circuit and the temperature equations involved
in each method.

4.2 Thermocouple

Cypress application note AN75511 - PSoC 3/PSoC 5LP Temperature Measurement with a
Thermocouple explains the theory behind the thermocouple terminology; see the application note to
understand thermocouple temperature measurement. This section assumes that you have prior
knowledge of thermocouple terminology.

A thermocouple gives an output voltage that is directly related to the temperature difference between
two metallic junctions. The output voltage is not linearly related to temperature. The output voltage
versus temperature curve can be considered piece-wise linear with different slopes in different
temperature ranges. The relation between hot junction voltage and cold junction voltage is given by
the following equation.

VI = KT +V2 Equation 1

where the value of K depends on the temperature range. V1 is the voltage across the hot junction
and V2 is the cold junction compensation (CJC) voltage (see AN75511 for details on cold junction
compensation). T is the hot junction temperature.

Figure 4-1 shows the circuit used for thermocouple temperature measurement. A three-channel
ADC is used.

m Channel 0 is used for thermocouple voltage measurement

m Channel 1 is used for cold junction compensation

m Channel 2 is used for offset cancellation
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Figure 4-1. Thermocouple Circuit Diagram
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The cold junction compensation IC measures the cold junction temperature and outputs a voltage
proportional to the temperature. The ADC measures the cold junction output voltage to calculate the
cold junction temperature. This temperature is used to calculate the cold junction compensation, V2.

V1 is measured in the first ADC channel. The temperature can be calculated using equation 1 if V1,
V2, and K are known.

The lower potential lead of the thermocouple connector is biased at a potential above ground so that
negative temperatures up to —270 °C can be measured after accommodating for small negative
device offset. PSoC Creator provides a thermocouple component that supports all thermocouple
types (B, E, J, K, N, R, S, and T) and simplifies voltage-to-temperature conversion and vice versa.

Thermistor

Application note AN66477 - PSoC 3 and PSoC 5LP Temperature Measurement with Thermistor
explains the thermistor theory and temperature measurement with thermistor. This section assumes
that you are aware of thermistor fundamentals and terminology.

The thermistor resistance changes with temperature in a nonlinear fashion. Thermistor
manufacturers provide the thermistor temperature versus resistance table. The Steinhart-Hart
equation (equation 2) characterizes thermistor resistance change with temperature to a good
accuracy and can be used to find temperature from thermistor resistance.

1A BInR+CIn(R)?
T Equation 2

where,
- A, B, and C are the Steinhart-Hart coefficients
- R is the resistance at temperature T expressed in Kelvin

Figure 4-2 shows the circuit diagram used for the measurement. An excitation voltage is applied
across a series combination of thermistor and precision reference resistor, and the voltages across
thermistor and reference resistor are measured.
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Figure 4-2. Thermistor Circuit Diagram

] 0
R V1
+ y M
R, X
10K v2
0.1%
2
In Figure 4-2, V1 is the voltage across the thermistor resistance, R; and V2 are the voltage across the
reference resistance R, Equation 3 provides the thermistor resistance.
Vi
R =—*R
t V2 r .
Equation 3

The voltage ratio ensures that any gain error and drift associated with the ADC are eliminated. The

accuracy of the thermistor resistance, R;, is determined mainly by the accuracy of the reference

resistance, R,. From R;, the temperature can be calculated using the Steinhart-Hart equation.

PSoC Creator provides a thermistor component for PSoC Creator, which makes it easier to interface

a thermistor to PSoC 3 or PSoC 5LP. The component provides the flexibility of using either a lookup

table (LUT) or the Steinhart-Hart equation and provides simple C functions to compute temperature

from resistance.
4.4 RTD

Application note AN70698 - PSoC 3 and PSoC 5LP Temperature Measurement with RTDs explains
the RTD fundamentals and RTD temperature measurement. This section assumes that you are
aware of the RTD terminology.

In an RTD, the resistance variation with temperature is given by Callender Van Dusen equations
(equations 4 and 5).

2
Rrtp = Rp(1+ AT +BT“),T >0 Equation 4

2 2
Re1p = Ro(1+ AT + BT2 + C(T —100)T?),T <0 Equation 5

where,

- Rr7p is the resistance at temperature T expressed in °C
- Ry is the resistance at 0 °C (equal to 100 Q for PT100 RTD, one of the commonly used RTDs)

- A, B, and C are Callender Van Dusen coefficients

By determining the resistance of the RTD, you can find the temperature using equations 4 or 5.
Figure 4-3 shows the circuit used to measure RTD resistance.
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Figure 4-3. RTD Circuit Diagram
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One of the PSoC 3 or PSoC 5LP IDACs is used to force a current through the RTD, and the delta
sigma ADC is used to measure the voltage across the RTD. The RTD resistance (V/l) is calculated
and hence the temperature is obtained. Precise 100-Q (0.1%) reference resistance is used to
accurately measure the current forced using IDAC, thereby eliminating any gain error and drift
associated with the ADC and IDAC. First the IDAC current is passed through the reference resistor
(Rref) and the voltage across the reference resistor (Vref) is measured using ADC. The same current
is then passed through the RTD and the voltage across RTD (Vrtd) is also measured using ADC.
The RTD resistance is calculated using the equation:

Vrtd

R = .
RTD (Vref/Rref ) Equation 6

PSoC Creator provides an RTD component that helps to convert resistance to temperature.
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4.5 Diode

Application note AN60590 - PSoC 3 and PSoC 5LP Temperature Measurement using Diode
explains the theory behind diode temperature measurement. This section provides only a short
description of the method. The current through a forward-biased diode is given by the equation:

| = 1.EXP Vj
nV; Equation 7

V is the diode forward voltage drop

where,

Is is the reverse saturation current

n is the constant that has a value between 1 and 2, depending on the material and physical structure
of the diode

V7 is the thermal voltage calculated with the equation

where,

k is the Boltzmann's constant

T is the absolute temperature in Kelvin
q is the magnitude of electron charge

By passing two currents 14 and |, and measuring the respective voltages V4 and V5, the temperature
can be calculated using the following equation.

T =

q n-v,
nk ln[jlf ]

2 4

Equation 8

Figure 4-4 shows the circuit diagram used for diode temperature measurement. Note that two diodes
are connected antiparallel to each other. This helps to measure two temperatures using only four
pins.
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Figure 4-4. Diode Circuit Diagram and Diode Connected Transistor
(a) Diode Circuit Diagram (b) Diode Connected Transistor
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In Figure 4-4 (a), D1 and D2 are diode connected transistors (See Figure 4-4 (b)). While measuring
the temperature using diode D1, MUX1 channel1 and MUX2 channel2 are active. While measuring
the temperature using diode D2, MUX1 channel2 and MUX2 channel1 are active.

MXCZ

By passing two currents |4 and |, and measuring the respective voltages V4 and V,, the temperature

is calculated using equation 8. The ADC measures a negative voltage in one of the two cases, which
can be negated in firmware to make it positive. Measurements are made in four-wire configuration to
avoid series resistance error.
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51 Overview

Example projects are divided into three project areas based on end applications. Each project area
contains examples for the CY8CKIT-030, CY8CKIT-050, and CY8CKIT-001 development kits (DVK).
The CYB8CKIT-030 DVK contains a PSoC 3 (8051 core) and CY8CKIT-050 DVK contains a
PSoC 5LP (ARM Cortex-M3); both support high-performance analog applications. The CY8CKIT-
001 DVK can be used to develop solutions for the PSoC 1 (M8C proprietary core), PSoC 3 (8051
core), or PSoC 5LP (ARM Cortex-M3). The example projects provided with the kit support PSoC 3
(8051) and PSoC 5LP (ARM Cortex-M3).

The Tempsense example project supports most temperature sensing applications. It provides high-
performance temperature sensing by using the ADC in 20-bit mode and implementing a high-preci-
sion linearization algorithm. It includes a resistive temperature detector (RTD), thermocouple, therm-
istor, two temperature diodes, and an IC temperature sensor. You can evaluate and compare sensor
performance. Complete interface and output signal correction solutions can be developed for each
type of temperature sensor.

The Sequenced ADC example project includes three temperatures (RTD, temperature diode, and IC
temperature sensor) as well as millivolt and voltage inputs. This example project can be used for
sensing applications requiring temperature measurement (such as RTD) and other types of voltage
output sensors. The example is also useful in system monitoring applications requiring temperature
(usually temperature diode or IC temperature sensor) and voltage rail measurement. This example
project uses the ADC in 16-bit mode and provides higher throughput. In this project, the ADC read-
ings are automatically repeated at consistent intervals. This consistent time interval allows filtering of
ADC readings to remove specific frequencies of interest, such as 50- and/or 60-Hz hum.

The Thermal Management System supports fan control applications. Adding a CY8CKIT-036 evalu-
ation kit (with two four-wire fans) to the CY8CKIT-025 EBK and a development kit supports complete
temperature-based fan control solutions. For more details on the CY8CKIT-036 PSoC Thermal Man-
agement EBK, click here.

Example Projects:
m Tempsense - Measures the temperature of six temperature sensors

o TempSense _030_050 - Works with PSoC 3 DVK CY8CKIT-030 and PSoC 5LP DVK
CY8CKIT-050

o TempSense 001 - Works with PSoC DVK CY8CKIT-001
m Sequenced ADC - Measures three temperatures, two voltage rails, and two generic analog inputs

o SequencedADC_030_050 - Works with PSoC 3 DVK CY8CKIT-030 and PSoC 5LP DVK
CY8CKIT-050

o SequencedADC_001 - Works with PSoC DVK CY8CKIT-001
m Thermal Management System - Controls fan speed based on temperature

o Thermal Management System_030_050 - Works with PSoC 3 DVK CY8CKIT-030 and
PSoC 5LP DVK CY8CKIT-050

o Thermal Management System_001 - Works with PSoC DVK CY8CKIT-001
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Migrating Projects to use with CY8CKIT-050 and CY8CKIT-010

By default, the project works with PSoC 3. To use the project for PSoC 5LP, change the device to
CY8C5868AXI-LP035 (Project > Device Selector). If the CY8CKIT-001 project is being updated for
use with the PSoC 5LP processor module, you must also change the CMOD pin mapping from P2_7
to pin 15_5.

The following sections provide a detailed description of these example projects.

Tempsense

This example project demonstrates high-precision, high-accuracy, multi-channel temperature sens-
ing using PSoC.

Project Description

This project displays the temperature measured using a thermocouple, IC sensor, thermistor, RTD,
and two diodes. It also provides steps to calibrate the RTD, diode, and IC. The user interface of this
example is controlled by two CapSense® buttons, a CapSense slider, two mechanical push buttons,
and a character LCD.

When the example project for CY8CKIT-030 is programmed, the LCD displays a welcome message
for one second. It then displays the temperature from the thermocouple, which is the first item in the
user selectable menu. CapSense buttons P5_5 and P5_6 act as the scroll down and scroll up menu
buttons, respectively. A mechanical switch connected to P6_1 is used to proceed through various
calibration steps. A CapSense slider is used to set the calibration temperature.

The menu has the following items:

Thermocouple temperature display

IC temperature display

Thermistor temperature display

RTD temperature display

Diode1 temperature display

Diode2 temperature display

Simultaneous temperature display labels (see Figure 5-1)

Simultaneous temperature display from all 6 sensors (see Figure 5-2)

Calibrate RTD temperature

Calibrate Diode1 temperature

Calibrate Diode2 temperature

Calibrate IC sensor temperature

In the simultaneous display, the first row displays the temperature of the thermocouple, IC, and
thermistor. The second row displays the temperature of the RTD, diode 1, and diode2, as shown in
Figure 5-2.

Figure 5-1. Simultaneous Temperature Display Labels
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Figure 5-2. Simultaneous Temperature Display for All Six Sensors

Thermocouple IC Thermistor

7.4
Eﬁu E"

RTD Diode1 Diode2

5.2.2 Project Operation

5.22.1 Hardware Connections

The kit includes example projects for the CY8CKIT-001 DVK, CY8CKIT-030 DVK, and CY8CKIT-050
DVK hardware platforms. The pin mapping for CY8CKIT-030 and CY8CKIT-050 are identical; follow
the instructions provided for CY8CKIT-030 PSoC 3 DVK for CY8CKIT-050 PSoC 5LP DVK as well.

The main difference between the examples for the CY8CKIT-001 and CY8CKIT-030 platforms is the
PSoC pin mapping. The project provided for the CY8CKIT-001 PSoC DVK can be used with both
PSoC 3 and PSoC 5LP. See Migrating Projects to use with CY8CKIT-050 and CY8CKIT-010 on
page 32 for more details.

5.2.2.1.1 CYB8CKIT-030 PSoC DVK
1. Plug the PSoC Precision Analog Temperature Sensor EBK to port E of the CY8CKIT-030 DVK.

2. No jumper wires are required for the PSoC 3 DVK examples because the mechanical buttons are
hard-wired to GPIOs. Ensure that the LCD included with the PSoC 3 DVK is attached.

3. Set VDDD and VDDA to 3.3 V using J10 and J11.

4.

Operation chapter on page 19.

Note: When using the CY8CKIT-025 EBK with CY8CKIT-050 PSoC 5LP DVK, remove the jumpers
from J43 and J44 on PSoC 5LP DVK.
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5.2.2.1.2 CY8CKIT-001 PSoC DVK
1. Plug the PSoC Precision Analog Temperature Sensor EBK to port A of the CY8CKIT-001 DVK.

L
™
e
-
-
oo
e
=
-
-
L
-
-
——
E
St
—
P
i

SGNDE =
2. In the pin header/breadboard area of the CY8CKIT-001 base board, use jumper wires to make
the following connections:
a. SW1toP1_7

b. SW2to PO_7

----------
.....

-----
-----

VBUS |
5V SOURCE
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4. Ensure that the LCD included with the PSoC DVK is attached and the LCD power jumper (J12) is

in the ON position.

POWER |

In the CY8CKIT-025 EBK, choose appropriate jumper settings for internal sensors; see the Kit
Operation chapter on page 19.

5.2.2.2 Run Tempsense Example Firmware

5.2.2.2.1 CY8CKIT-030 PSoC 3 DVK
The steps to run the example firmware on CY8CKIT-030 are:

1.

7.
8.
9.

Attach a USB cable from the PC to the PSoC 3 DVK program/debug USB port (use J1, the USB
connector closest to the corner of the board).

Open the Tempsense_030_050 project using PSoC Creator and select Debug > Program to pro-
gram the PSoC.

Detach the USB cable and connect hardware according to Hardware Connections on page 33.
Attach the USB cable again from the PC to the PSoC 3 DVK program/debug USB port (use J1).

Press the Reset (SW1) button on the PSoC 3 DVK to run the newly programmed firmware
image.

. On reset, the LCD displays a welcome message and the temperature reading from the thermo-

couple, which is the first item in the user selectable menu. SW2 can be used to toggle the cold
junction compensation sensor between the IC (DS600) and thermistor.

Press CapSense button P5_5 to scroll down the menu and P5_6 to scroll up the menu.
Use SW2 to proceed through the calibration steps; see RTD Calibration on page 47.
Use SWa3 to return to the previous step during calibration.

5.2.2.2.2 CYB8CKIT-001 PSoC DVK

The steps to run the example firmware on CY8CKIT-001 are:

1.
2.

Apply 12-VDC power to the PSoC DVK.

Attach the MiniProg3 device, first to a USB port on the PC and then to the PROG port on the
CY8CKIT-009 PSoC 3/CY8CKIT-010 PSoC 5LP processor module.

. Open the Tempsense_001 project using PSoC Creator and select Debug > Program to program

the PSoC.

Disconnect power to the PSoC DVK and connect hardware according to Hardware Connections
on page 33.

Power the PSoC DVK.

On reset, the LCD displays a welcome message and the temperature reading from the thermo-

couple, which is the first item in the user selectable menu. SW1 can be used to toggle the cold
junction compensation sensor between the IC (DS600) and thermistor
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7. Press CapSense button PO_5 to scroll down the menu and PO_6 to scroll up the menu.
8. Use SW1 to proceed through calibration steps; see RTD Calibration on page 47.

9. Use SW2 to return to the previous step during calibration.

Testing the Project

For best results when testing temperature measurements, ensure that you have good thermal con-
tact between the sensor and your reference thermometer. Also, make sure there is minimal air flow,
which can result in temperature gradient. Sample test results are given in the following sections.

Expected Performance and Test Results

This section explains the expected resolution and accuracy of the temperature displayed by all the
sensors.

Accuracy

The accuracy of the temperature displayed depends on the sensor and the signal chain.

Sensor

Each sensor has a tolerance, which is available in the datasheet provided by the sensor manufac-
turer. The tolerance indicates the error due to replacement of one sensor with another of the same
part number. The tolerance of each onboard sensor is listed in Table 5-1. These numbers are from
the respective sensor datasheets.

Table 5-1. Temperature Sensor Tolerances

Sensor Tolerance Standard Maximum Tolerance | Maximum Tolerance
Error at 25 °C Error at 100°C

Thermocouple ASTM special limits of error

o 0, H H ] o
5SRTC-GG-K-20-36 1:1 C or 0.4%, whichever is +1.1°C +1.1°C

higher

Thermistor 1% at 25 °C o o
NCP18XH103F03RB 1% B-value tolerance $04°C t2°C
RTD IEC Class B RTD o o
PTS080501B100RP100 (0.30 + 0.005T) °C £0.43°C +08°C
Diode - - -
IC - +05°C +05°C

For diode, the ideality factor is the source of its tolerance. This number is generally not mentioned in
the diode datasheet and must be determined experimentally. Diode ideality factor generally lies
between 1 and 1.01. An ideality factor difference of 0.004 (using 1.008 instead of 1.004) causes an
error of around 2 °C. See AN60590 - PSoC 3 and PSoC 5LP - Temperature Measurement with a
Diode for more details on these calculations.

Signal Chain

Signal chain error includes the errors due to the ADC, IDAC, the calibration (reference) resistors and
the measurement method. The resources used differ from sensor to sensor.

The main sources of ADC error are its offset, gain error, and INL. Of these, the offset error is can-
celled in all cases by correlated double sampling. ADC gain error is eliminated by using a precision
reference resistor in thermistor and RTD.
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The main sources of IDAC error are its offset, gain error, and INL. The IDAC errors are completely
removed by passing the IDAC current through a precise reference resistor and measuring the volt-

age across it.

The reference resistor tolerance determines the error caused by it. A 0.1% reference resistance is

used in both RTD and thermistor temperature measurements.

The error component caused by the signal chain for each sensor is listed in Table 5-2.

Table 5-2. Signal Chain Errors for PSoC 3

Sensor Signal Chain Error Components Typ/Max Error at 25 °C | Max Error at 100 °C
ADC gain error, INL, cold junction IC
Thermocouple sensor error (+ 0.5 °C) 0.1/2A1 2.2
Thermistor ADC INL, reference resistor tolerance 0/0.05 0.6
RTD ADC INL, reference resistor tolerance 0.1/0.5 0.9
Diode ADC gain error, INL 0.3/2.6 3.8

Cypress application notes on each of the four sensors explain the signal chain errors in d

5.2.2.4.2 Resolution (peak to peak)

etail.

The temperature measurement resolution is the minimum temperature increment possible. A 0.1 °C
resolution is achieved on all sensors. A software IIR filter (see Sensor Output Filter on page 51) is
applied on some sensors to achieve 0.1 °C resolution. The application notes associated with each
sensor gives more details on how 0.1 °C resolution is achieved on each sensor. Generally, a small
flicker is seen on the LCD temperature display. A small flicker of 0.2 °C on thermocouple readings,
0 °C on IC and thermistor, 0.1 °C on RTD, and 0.3 °C on diode at a very small rate has been
observed in the example projects. It can be reduced by additional filtering at the cost of temperature
settling time. The IIR filter can be changed in firmware, as shown in Sensor Output Filter on page 51.

5.2.2.4.3 Test Results

This section shows the test results on the sample board. Wherever possible, measurement tech-

niques are used to identify the signal chain performance of PSoC.

Thermocouple

Thermocouple input can be simulated by a millivolt source. This eliminates any error due to thermo-
couple tolerance and allows you to test the signal chain in the whole temperature range without a
heat source. A millivolt source is fed to the thermocouple inputs and the cold junction temperature is
forced to 0 °C in the example project. The temperature shown by PSoC is noted and the voltage
input is measured using an accurate voltmeter; the temperature corresponding to that voltage is cal-

culated using NIST tables. The expected results and actual results are listed in Table 5-3.

Table 5-3. Thermocouple Test Results

Simulated thermo-emf Voltgge read by Expected Obtained Error (°C)
(mV) multimeter (mV) temperature (°C) | Temperature (°C)
-5 —4.695 -141 -141.1 0.1
—4 —-3.666 -103.7 -103.7 0
-3 -2.575 —69.6 -69.5 -0.1
-2 -1.741 —45.9 —45.7 -0.2
-1 —-0.654 -16.77 -16.7 -0.1
0 0 0 0 0
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Table 5-3. Thermocouple Test Results
Simulated thermo-emf Voltqge read by Expected . Obtained ) Error (°C)
(mV) multimeter (mV) temperature (°C) | Temperature (°C)
1 0.666 16.7 16.7 0
2 1.754 43.46 434 0.1
3 2.58 63.5 63.5 0
4 3.663 89.5 89.4 0.1
5 4.712 114.9 114.9 0
10 9.582 235.9 235.8 0.1
20 19.58 475 475 0
30 28.76 691.2 691.1 0.1
40 39.54 955.75 955.8 -0.1
50 49.816 1227 1226.9 0.1
Thermistor

A thermistor can be simulated by a potentiometer. By varying the potentiometer resistance, you can
simulate temperatures in the whole temperature range of the thermistor. A potentiometer resistance
is used to provide resistance in the whole thermistor temperature range; the thermistor temperature
measured by PSoC is noted. The resistance is also measured by an accurate multimeter and the
expected temperature is calculated using the Steinhart-Hart equation. Table 5-4 shows the results.

Table 5-4. Thermistor Test Results

Resistance in ohms Expected Temperature Measured Temperature Signal Chain Error

(Multimeter Measurement) P P (°C) (°C)
99318.0 -27.6 -27.60 0.00
32593.0 -4.0 —4.1 -0.10
12135.0 19.9 19.9 0.00
10000.0 25.0 25 0.00
6951.0 35.0 35 0.00
4230.0 495 49.6 0.10
3021.0 60.0 60 0.00
2065.0 72.6 727 0.10
1260.0 90.2 90.2 0.00

977.6 99.9 99.9 0.00

800.8 107.8 107.8 0.00

549.5 123.5 123.6 0.10

419.3 135.6 135.5 -0.10

308.3 150.1 150 -0.10

270.0 156.6 156.5 -0.10

189.3 175.1 175 -0.10

122.7 199.7 199.5 -0.20

RTD

An RTD can be simulated by a potentiometer. By varying the potentiometer resistance, you can sim-
ulate the temperature in the whole temperature range of the RTD. A potentiometer is used to provide
resistances in the whole RTD temperature range; the RTD temperature measured by PSoC is noted.
The resistance is also measured by an accurate multimeter and the expected temperature is calcu-

38
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lated using Callender Van Dusen equation. Table 5-5 shows the results .

Table 5-5. RTD Test Results

Resistance in Ohms Expected Temperature | Measured Temperature | Temp Measure Error
(Multimeter Measurement) (°C) (°C) (Signal Chain) (°C)

79.85 -51.1 -51.3 -0.20

100.06 0.2 0.2 0.00

110.76 27.6 27.7 0.10

120.25 52.2 52.1 -0.10

133 85.5 85.3 -0.20

138.5 100.0 100 0.00

150 130.4 130.3 -0.10

194.4 250.8 251 0.20

280.85 499.8 500 0.20

315.7 606.2 606.2 0.00

371.8 787.0 787.3 0.30

Diode

Diode temperature accuracy is tested in a temperature forcing system by forcing a specific tempera-
ture and comparing the diode results with those of a standard thermometer. The standard microther-
mal thermocouple thermometer, with an accuracy of 1.3 °C (including thermocouple probe error), is
used. Table 5-6 shows the results.

Table 5-6. Diode Test Results

" Standard Thermometer |+ (with PS0C) (G | Diode Temperature Error ()

0.8 12 0.4

6.2 56 06

17 16.1 0.9

22 21 1

30 293 07
753 747 06
99.5 99.4 0.1

DS600 IC Sensor

The IC sensor signal chain accuracy is tested by measuring the voltage output by the IC at various
temperatures and calculating the expected temperature and comparing it to the temperature dis-
played by PSoC. Sample test results at a few temperature points are shown in Table 5-7.

Table 5-7. IC Sensor Test Results

IC Output Voltage (mV) | Expected Temperature (°C) | Observed Temperature (°C) Error (°C)
640.32 20.4 20.4 0.0
660.34 23.5 23.5 0.0
702.22 30.0 0.0
733.73 34.8 34.8 0.0
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5.2.2.4.4 Simultaneous Temperature Display of all Six Sensors

The sensor-to-sensor variation in temperature is 0.5 °C to 1.1 °C without calibration. The signal
chain can add additional error. Remember the following thermal considerations to understand the
temperature difference between the sensors in the simultaneous display of six temperatures.

m The thermocouple measures the air temperature; the RTD and thermistor measure the board
temperature; the IC measures the temperature of the exposed pad below it; and diodes are
screwed on to the board although they hang in the air.

m Because the thermocouple measures the air temperature, it is about a degree Celsius lower than
the board at room temperature. Place the tip of the thermocouple on the board and you will see
the thermocouple temperature rise by a degree.

m Place the board in the sun; you will note that the temperature display shown by the onboard sen-
sors slowly rise. In tropical regions, you can see the board temperature rise to greater than 50 °C,
while the thermocouple temperature will be around 35 °C to 37 °C.

m The IC sensor has a thermal pad underneath it. Ideally, it is expected to be isothermal with the
cold junction. Ensuring an isothermal connection requires providing good thermal contact
between the thermocouple cold junction and the exposed IC pad. If the thermal contact is not pro-
vided, having the cold junction IC very close to the cold junction terminals is sufficient. The tem-
perature difference between the cold junction terminals and the IC pad will not be more than
0.5 °C. Most thermocouple applications do not demand high accuracy and it is sufficient to have
the cold junction IC very close to the cold junction. The IC temperature is about 0.3 °C t0 0.5 °C
lower than the RTD and thermistor temperature because the exposed pad underneath the IC is
connected to ground. This is an offset error. This offset error can be eliminated by performing an
offset correction, as shown in IC Calibration on page 50.

Apart from the above thermal considerations, the sensor and bias resistor tolerances should deter-
mine the sensor temperature. Typically, RTD and thermistor temperatures are within about 0.3 °C of
each other; IC temperature and diode temperature is within about 0.5°C lower than the thermistor
temperature; and thermocouple temperature is about 1 °C to 2 °C lower than the thermistor temper-
ature.

5.2.2.45 CY8CKIT-001 PSoC DVK Thermistor Temperature

In the CY8CKIT-001 Tempsense project, a VDAC is used to supply voltage to the thermistor/resistor
network as opposed to an opamp used in the CY8CKIT-030 project. The CY8CKIT-025 EBK is
designed such that the opamp output pin 0_0 is connected to the thermistor/resistor circuit.

Port 0 of PSoC is not available for port A of CY8CKIT-001. Therefore, a VDAC is used to supply the
required voltage for the thermistor/resistor network. The opamp outputs only connect to port pins
0_0,0_1, 3 6, and 3_7 directly. The resistor network on port A is connected to pin 5 0. A VDAC is
used to supply the voltage at this pin. Due to the internal routing this connection has some parasitic
resistance, which causes a voltage drop. The ADC measures this voltage drop and compensates.
However, thermistor measurement on CY8CKIT-001 may result in higher error up to 0.5 °C. For
details on internal analog routing, see AN58827 - PSoC 3 and PSoC 5LP Internal Analog Routing
Considerations.

5.2.3 Project Details

5231 Project Schematic

Figure 5-3 shows the PSoC Creator schematic of the project. An eight-channel ADC is used to
sense the six sensors. The IDAC has four channels to provide excitation to the RTD and the diodes.
Whenever IDAC channel 2 is connected, the IDAC output flows through the diode connected transis-
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tor Q1, Pin 3_7 and to ground. The ground connection is provided on the pin in firmware. PSoC's pin
structure allows easy connection to the ground.

Figure 5-3. PSoC Creator Top Design

Connect PSoC Precision Analog Temperature Sensor Expansion Board Kit to PORT E on the PSoC 3 Development Kit-030
Excitation Sensors Sensing
1 Rdd40_ | Thermocouple 1 Thermistor 1
ID.‘\CIDAC Rtd 3 1 r I = i - Sl
3 CurrentMux —— fil——="=-- -4 PT100 RTDE(Z)™
Sy K-Type ares VM
il 4
_ Celib3d Y. S P .
! <=5y [
Diode 3 6 ! Ves ki
Pins | | Galb 4 4 |
L sl RTD_1
B Referenceg > « BTD
! Resistor ~ <
| R Galb 4 5., |
Diode 3 7 1 s
Pins i
il %_ i Vss RTD 2
g | gop---odet g ADCMux —
Opamp | ! il
Opamp | | | fo.__ ). Diode 4 3 | i
— ADC
1.024V [Vrel— | d ADC_DelSig
,,,,,, VTherm 0.0, | i
. |
fgt VTh 0_1 & 1 |
erm_0_ | .
IDAC Channels 0,1: L 3 eac|
0.RTD gy 3 -
1. Diode/RTD Reference resistor ] - 20-bit
IDAC Channels 2,3 and GndRefMux channels 0,1: = il
55
Whenever CurrentMux channel 2 is connected to IDAC, Te TeHouWnSignal 0 4.0, |
GndRefMux channel 1 is connected to Vssa. The OC =54 ADC Channels:
current flows through pin3_6 into Diode connected —= 1I§I1n:£J_n9_H§qlJ;5@ 4| 0. RTD ’
transistor Q1's base emitter junction and then flows 1' Diode/RTD Reference
through pin3_7 to vssa. current doesn't flow through ((‘:al\bramn] resistar
diode connected transistor Q2. TcColdJn_0_86 [w—— 2. Diode
Whenever CurrentMux channel 3 is connected to IDAC, i 1:::;:::3: Reference Resistor
GndRefMux channel 0 is connected to Vssa. The VSSA REF 0 2 5‘ Thermocouple
current flows through pin3_7 into Diode connected s i 6, Thermocouple Cold Junction
transistor Q2's base emitter junction and then flows. s VSSARER 03 | 7 Grolnd
through pin3_6 to vssa. Current doesn't flow through é ‘
diode connected transistor Q1. Vs

User Interface
User Inputs:
Capsense Button for menu up /down
Slider for calibration temperature selection

LCD to display temperature
and messages
CapSense
CapSense CSD| LCD
Character LCD
User Input:
Debouncer_1 Mechanical Buttons (with
Debouncer debounce logic) to proceed
— through calibration steps and
Pin_Cali Bekwrd = d e change cold junction sensor
source
neg {isr_: Bekwrd
clock
Debouncer_2
Debouncer
Pin_CalibrateStateFwd ——d qiE
neg isr_StateFwd
Clock_1[Jiii} clock
200Hz
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The ADC is configured in 20-bit mode for all sensors except the thermistor, where it is configured in
16-bit mode. Figure 5-4 shows the configuration used.

Figure 5-4. ADC Configuration

e Bialime) | [ Configure ‘ADC. Deisi™ 19 oo
Name: [aDC] Name ADC
- Configl Config2 Common Built-in 4k Configl "~ Config2 Common Built-in 4B
Comment: Defautt Corfig Comment Second Corfig
Conrfiguration name: CFG1 ADC_CFG1 Corfiguration name: CFG2 ADC_CFG2
Modes Modes
Conversion mode Conversion mode:
Resolution (bits): Resolution (bits} % -
Conversion rate (SPS):  [180 =] Range:8-1875PS Conversion rate (SPSE 10000 = Range: 2000 - 48000 SPS
Actual conv. rate (SPS). | 183 Actual conv_rate (SPS): | 9869
Clock frequency (kkHz): 2345120 Clock frequency kHz): | 640.000
Input options - Differential mode Input range Input options - Differertial mode InpLt range:
Input range: | +/-1.024V ( -Input +/- Vref ) - ‘ Input range:: | +/-1.024V ( -Input +/- Vref } -
Vdd Vdda
Buffer gain — _ __ ~es0mv Buffer gain: ___ ~650mV
Buffermode: | Level Shift - Buffer mode: | Level Shift -
Reference ADC Range Reference ADC Range
Reference: [Intemal 1.024 Votts - (Level Shift Mode) Reference: | Intemal 1.024 Volts - (Level Shift Mode)
Viref (V): 1.024 ‘ Viref (V): 1.024
I Alignment v — i — 00mv I Aignment
@ Right Cohsrency = LOW T @ Right Coherency = LOW
@ Left Bit-23 (OVF Protected) O Left 24 bits (OVF Protected)
) o] ||| G -

The ADC Buffer Mode is set to Level Shift because many of the voltages being read are near VSS;
this setting yields better ADC results for signals near VSS.

IDAC Configuration

The IDAC is configured in the 0 to 255 pA-range. The IDAC is used for RTD and diode temperature
measurements. The IDAC data register value is modified in firmware, as required for each of these

temperature measurements.
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Figure 5-5. IDAC Configuration

Configure IDACS’ [ 7 e
Name:
/" Configure | Buit-in 4P
IDAC
Polarity Speed
@ Positive (Source) Low Speed
) Negative (Sink) @ High Speed
_ Hardware Controlled O
Range () DAC Bus
D-FilETous (IO @ CPU or DMA (Data Bus)

@ 0-255uA (1 uA/bit)

Strobe Mode

0-204mA (8 uAbit) Biamal

@ Register Write
Value
uA: 127 || Hardware Enable
8bitHex 7F
Note: Changing any value
field recalculates the others
Datasheet Apply Cancel

Thermocouple

Firmware Description and Flowchart

Figure 5-6 illustrates the steps involved in thermocouple temperature measurement.

Example Projects

The temperature calculation flowchart for each sensor and the flowchart for calibrating RTD and
diode are explained in this section. A single point calibration is provided for RTD and diode.

This flowchart involves conversion of voltage to temperature and vice versa. The conversion is done
using thermocouple calculator component, which in turn uses the polynomial provided by NIST. The
mathematical conversion results in an error less than 0.07 °C.

The example project uses a K-type thermocouple. The component supports all thermocouple types
and provides application programming interfaces (APIs) for voltage to temperature conversion and
vice versa. IC (DS600) or thermistor can be used for cold junction compensation.
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Figure 5-6. Thermocouple Flowchart

Read Vssa Ref voltage for
correlated double sampling
(CDS)

Y

Read cold junction (CJ)
voltage

v

Convert CJ voltage to CJ
temperature

'

Convert CJ temperature to
CJ compensation voltage.

'

Read hot junction voltage,
perform CDS and filter

y

Add hot junction voltage to
CJ compensation voltage

v

Convert voltage to
temperature
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5.2.3.3.2 Thermistor

Figure 5-7 shows the thermistor temperature calculation flowchart.

Figure 5-7. Thermistor Flowchart

Read Vssa Ref voltage for CDS

'

Read voltage across thermistor
reference resistor (Vref) and
perform offset cancellation(CDS)

v

Read voltage across thermistor
(Vt) and perform offset
cancellation(CDS)

!

Calculate thermistor resistance
from Vref and Vit

v

Calculate temperature from the
thermistor resistance

Example Projects

The flowchart involves conversion of thermistor resistance to temperature. This is done using the
thermistor calculator component. The component supports both LUT and the Steinhart-Hart equa-

tion, and provides an API for converting resistance to temperature.
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5.2.3.3.3 RTD
Figure 5-8 shows the RTD temperature calculation flowchart.
Figure 5-8. RTD Flowchart

(  Start )

y

Set IDAC to source 128 uA l
current

Read voltage across RTD
sensor at zero current for CDS

Y

Connect IDAC current mux to
calibration reference resistor and \
measure voltage V4

CDS and filter V,

A

Y

Read voltage across
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The flowchart involves converting RTD resistance to temperature. The RTD calculator component is
used for this conversion. The RTD component chooses the correct polynomial order based on your
accuracy requirements.
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5.2.3.3.4 Diode
Figure 5-9. Diode Flowchart
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5.2.3.3.5 RTD Calibration

The RTD provided onboard confirms to IEC-70651 class B standards. A class-B RTD conforms to

the following tolerance specifications.
Tolerance = 0.30 + 0.005]t|

This means replacing one RTD with another of the same part number causes a maximum error of
0.3°C at 0°C and 0.8 °C at 100 °C. Calibrating the RTD can help avoid this error. AN70698

describes the calibration details.

The calibration steps for the RTD are as follows:

1. Scroll down to the Calibrate RTD (eighth) item in the menu using CapSense buttons.
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2. Proceed through calibration steps using mechanical switch SW2 connected to P6[1] of CY8CKIT-
030 or SW1 connected to P1[7] of CY8CKIT-001.

3. The LCD displays "Set Temp:".

Force the RTD temperature to a known measured value between 0 °C and 100 °C and enter that
temperature using the CapSense slider and buttons. Use the CapSense slider for coarse temper-
ature setting and the CapSense button for fine settings (P5_5/P0_5 to increment the temperature
in 0.1 °C steps and P5_6/P0_6 to decrement the temperature in 0.1 °C). After the temperature is
entered accurately, press the mechanical button SW2 (CY8CKIT-030) or SW1 (CY8CKIT-001) to
calibrate.

4. The RTD calibration constant is calculated from the measured RTD resistance at the set temper-
ature and the expected temperature value entered by the user. After calibration, the LCD displays
the message "Calibrated". Press SW2 (CY8CKIT-030) or SW1(CY8CKIT-001) to go to the main
menu temperature display.

Figure 5-10. RTD Calibration
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Note: The calibration constant is used inside 'RTDRestoTemp' for calibration. On system reset, the
calibration constant is initialized as ‘1’. After calibration, the constant is stored in EEPROM. This
value can be used for power-on-reset calibration. This can be implemented by users and is not dem-
onstrated in this project.
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5.2.3.3.6 Diode Calibration

Diode temperature measurement follows the equation:

_q|Vi-Vo

)

Here n is the ideality factor of the diode, varied from diode to diode. The temperature variation result-
ing from the ideality factor variation can be calibrated out. As equation 9 shows, variation in n results
in a scale error. Performing a scale correction eliminates this error. The procedure to perform scale
calibration is as follows:

1. Scroll down to the Calibrate Diodel (ninth) or Calibrate Diode2 (tenth) item in the menu using
CapSense buttons. Proceed through the calibration steps using mechanical switch SW2 con-
nected to P6[1] of CY8CKIT-030 or SW1 connected to P1[7] of CY8CKIT-001.

2. The LCD displays “Set Temp:".

Force the diode1 temperature to a known measured value between 0 °C and 100 °C, and enter
that temperature using the CapSense slider and buttons. Use the CapSense slider for coarse
temperature setting and the CapSense button for fine settings (P5_5/P0_5 to increment the tem-
perature in 0.1 °C steps and P5_6/P0_6 to decrement the temperature in 0.1 °C). After the tem-
perature is entered accurately, press the switch SW2 in CY8CKIT-030 or SW1 in CY8CKIT-001 to
calibrate.

3. The diode calibration constant is calculated from the measured temperature and the expected
temperature value entered by the user. After calibration, the LCD displays the message "Cali-
brated". Press SW2 (CY8CKIT-030) or SW1 (CY8CKIT-001) to go to the main menu temperature
display.

Equation 9

Figure 5-11. Diode Calibration
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Note: The calibration constant is used inside diode temperature measurement function for calibra-
tion. On system reset, the calibration constant is initialized as ‘1’. After calibration, the constants are
stored in EEPROM. These values can be used for power-on-reset calibration. This can be imple-
mented by users and is not demonstrated in this project.

IC Calibration

DS600 IC is used for cold junction compensation. Ideally an isothermal connection should be pro-
vided between the cold junction sensor and cold junction terminals. If that is not possible, having the
cold junction sensor very close to the cold junction terminals is sufficient as it is done on CY8CKIT-
025. This may result in a small temperature offset of around 0.5 °C. For high accuracy, a calibration
routine, which performs a single point calibration, is provided to calibrate the temperature offset
between the cold junction and the IC thermal pads.

The calibration steps for the IC temperature measurement are as follows:
1. Scroll down to the Calibrate IC (eleventh) item in the menu using CapSense buttons.

2. Proceed through the calibration steps using mechanical switch SW2 connected to P6[1] of
CYB8CKIT-030 or SW1 connected to P1[7] of CY8CKIT-001.

3. The LCD displays "Set Temp:".

Force the IC temperature to a known measured value between 0 °C and 100 °C and enter that
temperature using the CapSense slider and buttons. Use the CapSense slider for coarse temper-
ature setting and the CapSense button for fine settings (P5_5/P0_5 to increment the temperature
in 0.1 °C steps and P5_6/P0_6 to decrement the temperature in 0.1 °C). After the temperature is
entered accurately, press the mechanical button SW2 (CY8CKIT-030) or SW1 (CY8CKIT-001) to
calibrate.

4. The IC calibration constant (Offset) is calculated as the difference in measured temperature and
the expected temperature value entered by the user. After calibration, the LCD displays the mes-
sage "Calibrated". Press SW2 (CY8CKIT-030) or SW1(CY8CKIT-001) to go back to main menu.

Figure 5-12. IC Calibration
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Note: The calibration constant is subtracted from the measured IC temperature inside 'Measure-
ColdJnSensorTemp' function, for offset calibration. On system reset, the calibration constant is ini-
tialized to ‘0’ and is set to the appropriate value after calibration. The calibration constant stored in
EEPROM can be used for power-on-reset calibration. This can be implemented by users and is not
demonstrated in this project.

5.2.3.3.8 Noise Reduction and Offset Cancellation

The accuracy of temperature reading displayed by a sensor depends on the ADC offset. Reducing
ADC offset increases the temperature accuracy. Similarly, electronic noise affects the resolution
measurement. A lower noise improves resolution. The techniques used in this example project to
reduce offset and noise for all sensors are described in the following sections.

Sensor Output Filter

A software IIR filter is applied on the output voltage of the thermocouple, RTD, and diode sensors to
eliminate noise. See application note, AN2099 - PSoC 1, PSoC 3, and PSoC 5LP - Single-Pole Infi-
nite Impulse Response (lIR) Filters, for details. The filter (attenuation factor) applied depends on the
noise on the output voltage of the sensor. The filter for a sensor is selected in such a way that the
temperature resolution of the sensor is 0.1 °C. The function FilterSignal() in the code performs filter-

ing.

Applying a filter increases the temperature settling time. A filter with a low cut-off frequency takes a
much larger time for the temperature to settle down. To avoid large settling times when the tempera-
ture changes drastically, an algorithm is used where the filter is applied only when required (when
the temperature is closer to the final temperature).

The filter attenuation factor can be changed in the filter.h file. For instance, to change the filter atten-
uation factor of the thermocouple from 4 to 5, go to filter.h and modify the following line of code.

/* Filter coefficient for sensors */

#define TC_FILTER_COEFF_SHIFT 4

Note: A higher attenuation factor reduces LCD flicker, but increases the temperature settling time.

Correlated Double Sampling (CDS)

Correlated double sampling is a technique where the offset and low frequency noise is eliminated by
subtracting a zero voltage reading from every voltage sample. See application note AN66444 for
more details on correlated double sampling. The ADC multiplexer, Channel 7, is used to make zero-
voltage measurements for the thermistor and the thermocouple. To make zero-voltage measure-
ments for the RTD and the diodes, pass a zero current through the RTD, diode, or calibration resistor
and measure the ADC output across the RTD/diode/calibration resistor.
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Sequenced ADC

This project demonstrates PSoC's ability to sense multiple inputs such as temperature sensor
inputs, power rails, and generic analog inputs at a specific sample rate where the 50- or 60-Hz noise
is eliminated.

Project Description

This project uses the RTD, IC temperature sensor, and diode temperature sensor from the
CYB8CKIT-025 DVK. This example also measures a 20-mV full scale input, 100-mV full scale input,
3.3-V rail, and 5-V rail. The 20 mV and 100 mV measurements require external stimulus. You can
uses a low noise voltage source or analog output sensors such as a pressure sensor or a load cell to
provide 0-20 mV and 0-100 mV inputs. The 5-V and 3.3-V signals can be derived from CY8CKIT-030
or CY8CKIT-001.

The project user interface is controlled by the CapSense buttons and character LCD. When the
example project is programmed on CY8CKIT-030, the LCD displays the measurement from the
RTD. Pressing CapSense button P5_5 successively displays measurements from the subsequent
temperature sensors and voltage inputs. These measurements are in the following order: diode tem-
perature, IC temperature, 3.3-V rail, 5-V rail, 20-mV full scale input, and 100-mV full scale input.
P5_6 can be used to cycle through the measurements in reverse order.

In the previous example, readings are only taken when the LCD displays that particular measure-
ment. However, in this project, ADC readings are taken continuously at repeated intervals. This
allows filtering of ADC readings to remove specific frequencies of interest, such as 50- or 60-Hz
hum. Furthermore, this project configures the delta-sigma ADC for 16-bit resolution instead of the
maximum 20-bit resolution. This allows faster ADC conversion times and measurement update
rates.

Project Operation

Hardware Connections

The kit includes example projects for the CY8CKIT-001 DVK, CY8CKIT-030 DVK, and CY8CKIT-050
DVK hardware platforms. The pin mapping for CY8CKIT-030 and CY8CKIT-050 are identical; follow
the instructions provided for CY8CKIT-030 PSoC 3 DVK for CY8CKIT-050 PSoC 5LP DVK as well.
The main difference between the examples for the CY8CKIT-001 and CY8CKIT-030 platforms is the
PSoC pin mapping. The project provided for the CY8CKIT-001 PSoC DVK can be used with both
PSoC 3 and PSoC 5LP. See Migrating Projects to use with CY8CKIT-050 and CY8CKIT-010 on
page 32 for more details.
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5.3.2.1.1 CY8CKIT-030 PSoC DVK
1. Plug the PSoC Precision Analog Temperature Sensor EBK to port E of the CY8CKIT-030 DVK.

PSoC from 0 to VDDA. On the CY8CKIT-030, the VR is directly tied to P6_5. Ensure that the VR
is turned to output 5 V. The VR is used to make sure that 5 V is not accidentally driven on the pin
if the system is set for 3.3 V.

4. Connect a 20-mV full scale differential signal from a voltage to source P5_2 (+) and P5_3 (-). You
can also use an analog output pressure sensor or load cell to give 0-20 mV input.

5. Connect a 100-mV full scale differential signal from a voltage to source P1_6 (+) and P1_7 (-).
You can also use an analog output pressure sensor or load cell to give 0-100 mV input.

6. Ensure that the LCD included with the CY8CKIT-030 DVK is attached to the LCD header.

Note: For testing purpose an external voltage source can be created by using 1.5-V AA battery
and resistor divider. Upper arm of the resistor divider can be 15 K resistor while bottom arm can
be 1 K potentiometer.
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8. In the CY8KIT-025 EBK, choose appropriate jumper settings for internal sensors; see the Kit
Operation chapter on page 19.

5.3.2.1.2 CYB8CKIT-001 PSoC DVK
1. Plug the PSoC Precision Analog Temperature Sensor EBK to port A of the CY8CKIT-001 DVK.

- v

PI2_0 P12_1

PR 114333003

2. In the pin header/breadboard area of the CY8CKIT-001 base board, use jumper wires to make
the following connections:

a. VRto PO_7. The VR is used as the 5-V input. Ensure that the VR is turned to output 5 V. The
VR makes sure that 5 V is not accidentally driven on the pin if the system is set for 3.3 V.

" ®* ® s e 0 0

L] L]
. L]
. L]
L] L]
L L]
L] .
L] .
L] .
L] -
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3. Connect a 20-mV full scale differential signal to PO_0 (+) and PO_1 (-).
4. Connect a 100-mV full scale differential signal to P1_6 (+) and P1_7 (-).

5. Set the system to run at 5 V using SW 3; set J7 VDD DIG and J6 VDD ANLG to VDD =5 V.

$ ] |
|- |vDD DIG]
VBUS, | SELECTI

6. Ensure that the LCD included with the CY8CKIT-001 PSoC DVK is attached and the LCD power
jumper (J12) is in the ON position.

7. In the CY8CKIT-025 EBK, choose appropriate jumper settings for internal sensors; see the Kit
Operation chapter on page 19.

5.3.2.2 Run Sequenced ADC Example Firmware
5.3.2.2.1 CYS8CKIT-030 PSoC 3 DVK

The steps to run the example firmware on CY8CKIT-030 are:

1. Attach a USB cable from the PC to the PSoC 3 DVK program/debug USB port (use J1, the USB
connector closest to the corner of the board).

2. Open the SequencedADC_030_050 project using PSoC Creator and select Debug > Program
to program the PSoC.

3. Detach the USB cable and connect hardware according to Hardware Connections on page 52.

4. Plug at 12-V wall-wart into the J4 barrel jack connector.

5. Press the Reset (SW1) button on the PSoC 3 DVK to run the newly programmed firmware
image.

6. On reset, the LCD displays the RTD temperature, which is the first item in the user selectable
menu.

7. Press CapSense button P5_5 to scroll up the menu and P5_6 to scroll down the menu.
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5.3.2.4.2

CYB8CKIT-001 PSoC DVK

The steps to run the example firmware on CY8CKIT-001 are:
1. Apply 12-VDC power to the PSoC DVK.

2. Attach the MiniProg3 device, first to a USB port on the PC and then to the PROG port on the
CYB8CKIT-009 PSoC 3/CY8CKIT-010 PSoC 5LP processor module.

3. Open the SequenceADC_001 project using PSoC Creator and select Debug > Program to pro-
gram the PSoC.

4. Disconnect power to the PSoC DVK and connect hardware according to Hardware Connections
on page 33.
5. Power the PSoC DVK.

6. On reset, the LCD displays a welcome message and then the RTD temperature, which is the first
item in the user selectable menu.

7. Press CapSense button PO_5 to scroll up the menu and PO_6 to scroll down the menu.

Note: The diode temperature in CY8CKIT-001 is slightly lower than the actual temperature. This is
because CY8CKIT-001 is a general-purpose board and is not optimized for analog routing.

Testing the Project

For best results when testing the temperature measurements, ensure that you have good thermal
contact between the sensor (RTD, diode, or IC sensor) and your reference thermometer.

Expected Performance and Test Results

This section provides details about the expected performance of the temperature, voltage, and
power rail measurements. The output expected from the temperature sensors are similar to those
described in the previous example project, except for minor differences, such as use of 16-bit ADC
for all measurements. It is recommended to see Expected Performance and Test Results on page 36
before reading this section. The focus of this example is to show multiplexing multiple input sources,
that is, voltages, temperatures, and power rails. The section Expected Performance and Test
Results on page 36 details the tolerance specification of each temperature sensor and the expected
temperature performance from the sensors.

Following are typical expected results for each measurement observed on a sample board.

Voltage (20 mV) Input

A voltage source is used to provide inputs from —20 mV to +20 mV and the output displayed by
PSoC is compared to a multimeter output.

The 20 mV reading should typically be within + 40 yV of the actual value. The ADC gain error is the
main factor driving this error and the PSoC 3 ADC with a maximum gain error of 0.2% keeps the
measurement inaccuracy to < 40 pV.

100-mV Input

A voltage source is used to provide inputs from —100 mV to +100 mV and the output displayed by
PSoC is compared to a multimeter output.

The 10-mV reading should typically be within + 200 yV of the actual value. The ADC gain error is the
main factor driving this error and PSoC 3 ADC with a maximum gain error of 0.2% keeps the mea-
surement inaccuracy to <100 pV.
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5.3.24.3 RTD
RTD temperature is simulated with a potentiometer, similar to the testing for the tempsense project.
Following are the test results.
Table 5-8. RTD Test Results
Actual Temp(°C) Measured Temp(°C) Difference(°C)
76.60 76.64 -0.04
37.14 37.06 0.08
20.44 20.5 —-0.06
0.13 0.03 0.10
-19.73 -19.77 0.04
—45.76 —45.82 0.06
5.3.2.4.4 Diode
The diode is typically within + 2°C. See the description in Expected Performance and Test Results on
page 36 to understand more about the expected error and thermal considerations. Table 5-9 pro-
vides an example of measured temperature. A standard thermometer with +1 °C accuracy is used
for comparison.
Table 5-9. Diode Test Results
Actual Temp (°C) Measured Temp (°C) Difference (°C)
0.8 1.2 0.4
6.2 5.6 -0.6
17 16.1 -0.9
22 21 -1
30 29.3 -0.7
75.3 74.7 -0.6
99.5 99.4 -0.1
5.3.2.4.5 DS600 IC Temperature Sensor

The DS600 typically is within £ 0.5°C. Table 5-10 provides an example of measured temperature. A
standard thermometer with +1 °C accuracy is used for comparison. Note that as mentioned in
DS600 IC Sensor on page 39, the IC measures the pad temperature below it and the IC signal chain

is accurate, as shown in Table 5-7 on page 39.

Table 5-10. DS600 IC Temperature Sensor Test Results

Actual Temp (°C) Measured Temp (°C) Difference (°C)
39.9 39.5 0.42
20.1 19.8 0.26
0.8 0.4 0.36
-19.7 —-20.0 0.31
-39.4 -39.8 0.40

5.3.2.4.6 3.3-V Rail

The 3.3-V rail is typically within + 20 mV. The ADC gain error is the main source of error.
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The 5-V rail is typically within £ 20 mV. The ADC gain error is the main source of error.

Project Details

The Tempsense project demonstrates a sensing implementation style where the sensor is only
sensed when its value is required. The ADC is controlled by firmware and the sensor is only sampled
when its value is displayed on the LCD. In many applications, sensors must be read all the time and
at precise intervals. The Sequenced ADC project implements ADC scanning in hardware and sam-
ples sensors at precise intervals. This ensures that sensor reading is always available for the appli-
cation.

Another reason for taking ADC readings continuously is the ability to filter certain frequencies such
as 50 Hz or 60 Hz hum on each reading. If the ADC readings are taken at consistent intervals, then
specific filters can be applied for each reading.

This project reads seven different inputs: a 20-mV full scale voltage, a 100-mV full scale voltage, an
RTD temperature sensor, a diode temperature sensor, a DS600 IC temperature sensor, a 3.3-V volt-
age rail, and a 5-V rail.

Some measurements such as RTD, diode, and IC temperature sensor require multiple readings to
generate the final result. For the RTD example, four ADC readings are required for each tempera-
ture: RTD, RTD CDS, reference resistor, and reference resistor CDS. Due to this, a total of 15 ADC
readings are required to generate the seven measurement values. Table 5-11 shows the ADC read-
ings that make up each measurement.

Table 5-11. ADC Reading

Measurement ADC Reading
20-mV Input 20-mV Input
RTD
RTD CDS
Reference Resistor

RTD

Reference Resistor CDS
100-mV Input 100-mv Input
Voltage Across Diode Current 1

Voltage Across Diode Current 2

Diode Reference Resistor Current1

Reference Resistor Current2

Reference Resistor CDS

DS600 Voltage
DS600 IC Temp Sensor

DS600 CDS
3.3-V Rail 3.3-V Rail
5-V Rail 5-V Rail

Project Schematic

Figure 5-13 shows the PSoC Creator schematic of the Sequenced ADC project. To facilitate ADC
readings at consistent intervals, a hardware counter is used to trigger the start of convert (SOC). The
SOC is automatically triggered by the hardware 16-bit counter "Scheduler". This counter triggers an
ADC reading every 606 us. The counter interval is selected to support the 15 ADC readings at a rep-
etition rate of 110 Hz per reading. To change this rate, change the ADC_PERIOD defined in sen-
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sors.h. Note that if this define is changed, the counter period should not run faster than the ADC
conversion rate and processing time for the ADC interrupt. The ADC conversion rate of 3861 sam-
ples per second takes 259 us. The processing time takes about 320 ys with the BUS_CLK set to 48
MHz.

Every time the ADC finishes a conversion, it triggers an interrupt, ADC_INT.c. In this interrupt, the
IDACS8, CurrentMux, ADCMux, and ADC are changed to prepare the signal chain for the next mea-
surement. Also, the ADC readings are filtered in this ISR. The filtered results are then stored in a
ping-pong buffer to be read later.

To ensure that the firmware in the ADC ISR executes before the next ADC SOC is triggered by the
scheduler, the counter "Slot Counter" is used. This hardware counter counts the number of SOCs
triggered by the scheduler. This count is compared against a software counter in the ADC ISR. If the
two counters do not match, then the reading is flagged as invalid.

The control register CtriIScheduler is used to control whether the scheduler is running. Setting this
control register low disables the scheduler and stops ADC readings.

IDACS is used to force current through the RTD, diode, and reference resistor. Diode P3_7 is used
to force GND collector of the diode.

Manual routing is used on the RTD to ensure that the load resistance of the IDAC does not cause
the value to droop between the reference resistor reading and RTD reading. For more information,
refer to AN70698.
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Figure 5-13. Schematic for Input Muxes and IDAC
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The IDAC values, ranges, and Current | "TTTT77F i e & ADC Channels:
Mux selection are sequenced in the file ; N3k b 0. RTD
ADC_INT.c ﬁq_< :)_ LI — 1. Diode/RTD
= >, Reference (calibration)
; : EE ¢ N resistor
34 < ) ,,,,,,,,,, AN - 2. Diode
= TRl 3. 20mV
&5 4.100mv
= 5. 3.3V
w IC 06 0 6. 5V Junction
L S 7. DS600
i . . .
©.g VSSA_REF_02 8 Ground
A 1 g 2 g —
i : g The ADCMux channels
At A L [ are sequenced in the
é 2 file ADC_INT ¢
Vss
Sequencer s
L3 ST = - SigBOC
SlotCounter
CriScheduler Countar
C Reg | Scheduler enable
—————lenable
B olock te}—+1 siat
control_0 snabls lenabla compl=)
0z el
Comp- +- - ml
SchodulerCLKJI—s in = s_owt count [ —=freset imermupt=
e . tock
[0} rosat intemuptlsl
MasCLK -~ clock
WASTRR, Gk 13

Tha counter “Schadular™ controls the Start of Convart (SOC) of the DelSigaADC. This counter is configured to produce a signal on the SOC
at & reguiar fixed interval. This is done so that the ADC readings happen at a foced rate. Completing the readings at a fived rate allows for
filtering of specific frequencies of interest such a 50 Hz or 60 Hz Hum. The rate of the ADC readings is determined by the period of
"Scheduler” the period can be changed by changing the define "ADC_PERIOD” in Readings.h. "Scheduler” counts at a rate of § MHz. The
rate of SOCs Is (1/6 MHz) * ADC_PERIOD.

Initially ADC_PERIOD is defined as 3606, This gives a rate of 60Tusec per SOC. Since we are taking 15 ADC readings, this allows for
each reading to occur every 9.015 msec, or 110 Hz

I changing ADC_PERIOD, ensura thal the period is not less than the combined ADC Sample Pariod, and the exacution time of the
software sequencer. The software sequencer is found in ADC_INT c. This file sequences the inputs 1o the ADC, ADC configuration, and
IDAC seitings. The sequencer alsa reads the ADC, and filters the readings. This file lakes ~320usec with a 48MHz BUS_CLK.

“SlotCounter” s used 1o count the number of S0Cs produced by “Sequencer” this counter is then read by the sequencer in software to
ensung it is in the comact sequencer slot

CrriScheduler is used to turn on and off the sequencer
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5.3.3.2 Component Configuration

Example Projects

As mentioned earlier, you need to take a total of 15 different ADC readings for the seven measure-
ments. Each of these readings requires different ADC configurations to achieve the maximum
dynamic range out of the ADC. For example, the 3.3-V and 5-V rail require the ADC to have a large
input voltage range. The same range yields imprecise results for the 20-mV input. To accommodate
these different sensors, four different ADC configurations are used. The ADC configurations are
switched in the ADC interrupt. Table 5-12 shows the 15 ADC readings and their ADC voltage range.

Table 5-12. ADC Reading and Voltage Range

Measurement ADC Reading ADC Input Range
20-mV Input 20-mV Input +0.064 V
RTD +0.256 V
RTD RTD CDS +0.256 V
Reference Resistor +0.256 V
Reference Resistor CDS +0.256 V
100-mV Input 100-mv Input +0.256 V
Voltage Across Diode Current 1 +1.024 V
Voltage Across Diode Current 2 +1.024 V
Diode Reference Resistor Current1 +0.064 V
Reference Resistor Current2 +0.064 V
Reference Resistor CDS +0.064 V
DS600 Voltage +1.024V
DS600 IC Temp Sensor
DS600 CDS +1.024V
3.3-V Rail 3.3-V Rall +6.144V
5-V Rail 5-V Rail +6.144 V
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The following images show the different ADC configurations.

Figure 5-14. £ 0.0

64 V ADC Configuration

Configurstion name:  CFG1
Modes

Resolution (bits): 16
Conversion rate (SPS): 357

Actual conv. rate (SPS): | 3571

Configure 'ADC_DelSig' —— s [@ ﬁj
Name [aDC]
" Configl |" Config2 | Config3 " Configd4 |* Common | Built-in 4
Comment: Default Config

Conversion mode: 0 - Single Sample -

ADC_CFG1

-

Range: 458 - 3571 5PS

W Clock frequency (kHz): 1000.000 |
Input options - Differential mode Input range
Il | iout enge: [+/0.084V (nput =/-Vief/16) ~] v
Buffer gain: e o _ _~650 mV
Buffer mode:
Reference ADC Range
Refersnce: | Intemal 1.024 Volis - (Level Shift Mode)
Wref (V): 1.024
|| Aigment Vesa———— ut v
@ Right Coherency = LOW % T

O Left 24 bits {OVF Protected)

L

=
=4 CYPRESS
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Note that Buffer Mode is set to Level Shift because many of the voltages being read are near VSS;
this setting yields better ADC results for signals near VSS.

The sample rate of 3861 is chosen such that each sensor is read at a repeat rate of 110 Hz.
Figure 5-15. + 0.256 V ADC Configuration

r
Configure 'ADC_DelSig' ——

? [ |

Name: ADC

Configl Conﬁgz] Config3 | Configd |” Common ©* Builtin 4 b

Comment Second Corfi

Corfiguration name: CFG2
Modes

Resolution (bits): 16

Conversion rate (SPS):  |3571

Actual conv. rate (SPS): | 3571

Input options - Differential mode

Conversion mode: 0 - Single Sample -

Clock frequency {kHz): 1000.000 |

g
ADC_CFG2

-

Range: 458 - 3571 SPS

Input range

| Inputrange:  [+/0.256V (dnput +/- Vief/4 ) > *

Buffer gain:
Buffermode: |Level Shit =

Reference

Vdd

_~650 mV

ADC Range

Reference: [Intemal 1.024 Volts

- (Level Shift Made)

Veef (Vi [1.024

Alignment
@ Right

Vssa

—_ — i T
100 mV
Coherency = LOW 6 — =

© Left 24 bits (OVF Protected)
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Figure 5-16. + 1.024 V ADC Configuration

Configure 'ADC_DelSig" S

Modes

Resolution (bits): 16 -
Conversion rate (SPS): 3572
Actual conv. rate (SPS):  [3572
Clock frequency (kHz): 1000.000

Input options - Differential mode

Name: ADC

Configl |* Config2 Conﬁg3| Config4 " Common [ Built-in 4k
Comment: Third Config
Configuration name: CFG3 ADC_CFG3

Conversion mode 0 - Single Sample -

Range: 458 - 10971 5PS

Input range

(| Imputrangs:  [+/-1.024V {nput +/- Vief )

d Vdd y

Buffer gain
Buffermode: |Level Shit -

Reference

_~650 mV

ADC Range

Reference: (Intemal 1.024 Volts

- (Level Shift Mode)

Viref (V) 1.024

Alignmert

O Left 24 bits (OVF Protected)

¥ __ _-lomv
® Right Coherency = LOW _f

Vssa

Figure 5-17. £ 6.144 V ADC Configuration

Configure 'ADC_DelSig' [
Name: ADC
Configl | Config2 | Config3 Conﬁg4] Common |~ Builtin 4 b
Comment: Fourth Config
Corfiguration name: CFG4 ADC_CFG4
Modes
Conversion mode 0 - Single Sample -
Resolution (bits): 16 -
Conversion rate (SPS): 3572 Range: 458 - 10971 SPS
Actual conv. rate (SPS): | 3572
| Clockfrequency fcHz): | 1000.000
Input options - Differential mode Input range
[l Input range: [+/-S_H4V{-Inpul +- 6°ref ) - N —
Y
Buffergain: |1 Vdda I
Reference
ADC Range
Reference: | intemal 1.024 Vlts - {Bypass Buffer Mods)
ref (V) 1.024
M Alignment Vssa
@ Right Coherency = LOW 6 — — 3L — _—10_%m_\f
© Left 24 bits {OVF Protscted)

Example Projects

Note that the Buffer Mode is set to Bypass Buffer because the voltage being read is near VDD; this
setting yields better ADC results for signals near VDD. However, the input impedance of the ADC is

lower without the buffer, so the input signal should not load the ADC.
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As stated earlier, the IDAC is used to force current through the RTD, diode, and calibration resistor.
Table 5-13 lists the IDAC range and values used for each sensor. The IDAC configurations are
switched in the ADC ISR.

Table 5-13. IDAC Range and Values

Measurement ADC Reading IDAC Range IDAC Value

RTD 2 mA 1.024 mA
RTD CDS 2 mA 1.024 mA

RTD Reference Resistor 2 mA 1.024 mA
Reference Resistor CDS 2 mA 0mA
Voltage Across Diode Current 1|255 pA 10 A
Voltage Across Diode Current 2 | 255 pA 100 pA

Diode Reference Resistor Current 1 | 255 pA 10 A
Reference Resistor Current 2 | 255 pA 100 pA
Reference Resistor CDS 255 pA 0 pA

5.3.3.3 Firmware Description and Flowcharts

5.3.3.3.1 ADC ISR Flowchart

The ADC ISR automatically prepares the signal chain for the next ADC reading. The ISR also filters
the current ADC reading and stores the filtered result in a ping pong buffer to be read later.

Figure 5-18 shows the ADC ISR flowchart. The ISR code is found in ADC_INT.c. This interrupt is
triggered at the end of every ADC conversion.
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Figure 5-18. ADC ISR Flowchart
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The SlotCounter is used to count ADC EOCs. This hardware counter is compared with the current
slot value in the ADC ISR. If they do not match, then the measurement is flagged as invalid. This is
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done after the ADC reconfiguration to ensure that reconfiguration completed before the next ADC
SOC is triggered.

Fixed Point Math

This project does not use floating point math when calculating the measurement results. This is done
to reduce processor overhead when converting ADC readings into measurement values. Therefore,
scaling is used to calculate the final measurement value. For ease of use, the values are converted
to float when displayed on the LCD. The following sections describe each measurement and how its
readings are converted into measurement values.

20-mV and 100-mV Input

For 20-mV and 100-mV reading, ADC_COUNTS_PER_VOLT is used to convert the ADC counts to
volts. Because integer math is used, dividing the ADC counts by this constant results in a precision
of only 1V, which is not adequate to measure a 20-mV or 100-mV full scale input. To fix this, the
ADC counts for these readings are scaled up by 10000 and divided by ADC_COUNTS_PER_VOLT.
The result is in ten-thousandths of a volt.

3.3-V Rail and 5-V Rail

For the 3.3-V and 5-V reading, ADC_COUNTS_PER_VOLT is used to convert the ADC counts to
volts. Because integer math is used, dividing the ADC counts by this constant results in a precision
of only 1V, which is not adequate to measure a 3.3-V or 5-V rail. To fix this, the ADC counts for these
readings are scaled up by 1000 and then divided by ADC_COUNTS_PER_VOLT. The result is in
thousandths of a volt.

RTD and DS600

To avoid floating point math, the conversion from ADC readings to temperature uses integer math.
To preserve precision, the readings are scaled up. Thus the final result of the temperature measure-
ments is in hundredths of a degree C. For more information on the conversion, see the inline code
comments in the associated project.

Diode

The diode temperature measurement uses floating point math. This is because the natural log of the
current ratio is taken. Not using floating point math with this measurement results in poor accuracy
and stability of the diode measurement.

Filter

A software IIR filter is applied on all ADC readings to eliminate noise. See application note AN2099
for details on the software IIR filter. The filter (attenuation factor) applied depends on the noise on
the voltage output of the sensor. Applying a filter increases the measurement settling time. A very
low cut-off filter requires a much larger time for the measurement to settle down. To avoid large set-
tling times when the input changes drastically, an algorithm is used where the filter is applied only
when required (when the measurement is closer to the final measurement).

The filter attenuation factor can be changed in the Init_Buffers routine in Readings.c. For example, to
change the filter attenuation factor of 3.3 V from 8 to 16, go to Readings.c and modify the following
line of code.

Filter_CoeffBuf[READ_RAIL3V3]=8;

to

Filter_CoeffBuf[READ_RAIL3V3]=16;

Note that a higher attenuation factor reduces LCD flicker, but increases temperature settling time.
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5.3.3.3.4 Correlated Double Sampling (CDS)
Correlated double sampling is a technique where the offset and low frequency noise is eliminated by
subtracting a zero voltage reading from every voltage sample. See application notes AN2226 and
AN66444 for more details on correlated double sampling. The ADCMux, Channel 8, is used to make
zero-voltage measurement for the DS600. To make zero-voltage measurement for the RTD and
diode, pass a zero current through the RTD, diode, or calibration resistor and measure the ADC out-
put across the RTD/diode/calibration resistor.

5.3.3.3.5 Calibration

For this project, user calibration is not available for the temperature sensors. The 3.3-V and 5-V
measurements are adjusted by a calibration factor. This is because the ADC configuration (+6.144 V
ADC input range) used to read the 3.3-V and 5-V rail is not factory calibrated. To achieve this calibra-
tion factor, a voltage is read with one of the factory calibrated ADC ranges (ADC configuration 1 —
+1.024 V range); that same value is read with the non-factory calibrated range. The ratio of these
two readings is then used to adjust the 3.3-V and 5-V measurements. This calibration is done before
the main code loop.
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54 Thermal Management

This project demonstrates fan speed control using analog temperature sensors.

5.4.1 Project Description

The thermal management project controls the fan speed based on the temperatures measured by

the temperature sensors. This project uses the CY8CKIT-036 Thermal Management (TME) EBK in

addition to the CY8CKIT-025 EBK. The example project controls two fans based on their zone tem-

peratures. The concept of a thermal zone and the sensors used in a specific zone are explained in

Project Details on page 75. On reset, the LCD displays Zone 1 Summary. Press switch SW2 to cycle

through the three menu items:

m Zone 1 Summary: Temperature algorithm used to compute zone temperature, desired fan speed,
and actual fan speed

m Zone 2 Summary: Temperature algorithm used to compute zone temperature, desired fan speed,
and actual fan speed

m Temperature Sensor Summary: The temperatures of the individual temperature sensors in each
zone and the zone temperatures

Figure 5-19. Thermal Management EBK

12C Temperature Sensor 12G/SMBus/PMBus Port

— 2x20 Pin Headers

| MODEL DB04028B12U
DC 12V==0.66A POSD
BALL BEARING

ﬁawl -
m L

+— Diode Temperature Sensor

4-Wire Fan __|
Socket

= PWM
Temperature
Sensor

0288 12U

MODEL Dag4

1-Wire Temperature Sensor Power Jack

54.1.1 Thermal Management EBK Description

The Thermal Management (TME) EBK contains two four-wire, 12-V brushless DC fans with connec-
tors to support an additional two fans for designers who need to prototype with their own specific fan
models. Six temperature sensors (four different kinds) are also installed on the kit:

m TMP175 12C digital temperature sensor

m Two TMPO05 PWM output digital temperature sensors
m DS18S20 "One Wire" digital temperature sensor

m Two MMBT3094 temperature diodes.
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This combination of hardware elements enables designers to rapidly prototype thermal management
solutions in a variety of configurations.

The TME EBK also provides an 12C/SMBus/PMBus compatible header to support systems that
require communication with a host controller. This functionality is implemented in a single PSoC 3.
The TME EBK routes the input/output signals for thermal management to a PSoC 3 mounted on a
development kit platform such as the CY8CKIT-001 or CY8CKIT-030. PSoC 3 is not mounted on the
TME EBK.

The CY8CKIT-036 TME EBK has three example projects that demonstrate firmware-based fan con-
trol, hardware-based closed-loop fan control, and a thermal management system. A detailed expla-
nation of the TME EBK and the firmware examples that are provided with the kit are available at
http://www.cypress.com/?rID=56655.

54.1.2 Using TME EBK with CY8CKIT-025

You can control the fans in the TME EBK using the temperature sensors in the CY8CKIT-025 EBK.
The TME EBK has only one analog temperature sensor, which is the diode-based temperature sen-
sor. To illustrate the analog temperature sensing capabilities of PSoC 3 better, the CY8CKIT-025
EBK is combined with the TME EBK to demonstrate thermal management using different analog
temperature sensors such as diode and RTD.

Figure 5-20 shows the CY8CKIT-036 TME EBK and CY8CKIT-025 EBK connected to the CY8CKIT-
030 PSoC 3 DVK. The CY8CKIT-025 EBK is connected to port E and the CY8CKIT-036 TME EBK is
connected to port D. The same setup and connections can be used when using CY8CKIT-050.

Figure 5-21 shows the CY8CKIT-036 TME EBK and CY8CKIT-025 EBK connected to the CY8CKIT-
001 PSoC DVK. The CY8CKIT-025 EBK is connected to port A and the CY8CKIT-036 TME EBK is
connected to port B. The same setup and connections can be used when using CY8CKIT-010.

Figure 5-20. TME EBK and CY8CKIT-025 EBK Connected to CY8CKIT-030 PSoC 3 DVK
| —
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Figure 5-21. TME EBK and CY8CKIT-025 EBK Connected to CY8CKIT-001 PSoC 1 DVK

54.2 Project Operation

54.2.1 Hardware Connections

The CY8CKIT-025 kit includes example projects for the CY8CKIT-001 DVK, CY8CKIT-030 DVK, and
CYB8CKIT-050 DVK hardware platforms. The pin mapping for CY8CKIT-030 and CY8CKIT-050 are
identical; follow the instructions provided for CY8CKIT-030 PSoC 3 DVK for CY8CKIT-050
PSoC 5LP DVK as well except that PSoC 5LP device CY8C5868AXI-LP035 should be selected
(Project > Device selector). The main difference between the examples for the CY8CKIT-001 and
CYB8CKIT-030 platforms is the PSoC pin mapping.

54.2.1.1 CY8CKIT-030 PSoC 3 DVK

1. No jumper wires are required for the PSoC 3 DVK examples because the buttons and potentiom-
eter are hardwired to GPIOs. Ensure that the LCD included with the PSoC 3 DVK is attached.

2. Set VDDD and VDDA to 3.3 V using J10 and J11.
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Figure 5-22. CY8CKIT-030 PSoC 3 DVK Power Jumpers

3. Ensure that POT_PWR is enabled by installing a jumper on J30.
Figure 5-23. CY8CKIT-030 PSoC 3 DVK Potentiometer Power

CAUTION: The TME EBK plugged into port D of the CY8CKIT-030 DVK uses the SWD/JTAG pro-
gramming pins for fan control as well. Due to this pin sharing, the TME EBK should not be attached
to the CY8CKIT-030 DVK while programming the PSoC 3 device using MiniProg3 or DVKProg3 pro-
grammer. After the programming is complete, remove the programmer from the programming
header on the PSoC 3 DVK and then attach the TME EBK to port D. Due to pin sharing, debugging
the project is also not possible because it uses the same programming pins.

5.4.2.1.2 CYB8CKIT-001 PSoC DVK
1. In the pin header/breadboard area of the PSoC DVK base board, use jumper wires to make the
following connections:
0 VRtoP1_ 2

o SWi1toP2 7
Fig_ure 5-24. CY8CKIT-001 PSoC DVK Breadboard

HER1T P leo_o

nnnnnnnnnn

CTEDDT " [
94\/-0 2
e
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2. Setthe system to run at 3.3 V using SW3 and set J6 VDD DIG and J7 VDD ANLG to
VDD =3.3 V.

Figure 5-25. CY8CKIT-001 PSoC DVK Power Jumpers

SV SOURCE

3. Ensure that the LCD included with the PSoC DVK is attached and that the LCD power jumper
(J12) is in the ON position.

Figure 5-26. CY8CKIT-001 PSoC DVK LCD Power Jumper

4. Ensure that the VR_PWR jumper (J11) is installed.
Figure 5-27. CY8CKIT-001 PSoC DVK VR_POWER Jumper

e C10
L R14

Ju14  RADIO
RAD IO _PWR

" ,-rul“ .Lt“'l

(((IWJREL.... _—]‘“1

12 §

CAUTION: The TME EBK plugged into port B of the CY8CKIT-001 DVK uses the SWD/JTAG pro-
gramming pins for fan control as well. Due to this pin sharing, the TME EBK should not be attached
to the PSoC DVK while programming the PSoC 3 device on the DVK using MiniProg3 programmer.
After the programming is complete, remove MiniProg3 from the programming header on the PSoC
DVK and then attach the TME EBK to port B. Due to pin sharing, debugging the project is also not
possible because it uses the same programming pins.
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5.4.2.1.3 CY8CKIT-025 PSoC Precision Analog Temperature Sensor EBK

1. Make sure the RTD jumper J6 is on; short J8 1 and 2, 3 and 4 with wires so that the onboard RTD
is used for temperature measurements.

Figure 5-28. CY8CKIT-025 RTD Jumper

2. Connect the diodes, as shown in Figure 5-29.
Figure 5-29. CY8CKIT-025 Diodes

5.4.2.1.4 CYB8CKIT-036 Thermal Management EBK

1. Connect the fans to headers fan 3 and fan 4, as shown in Figure 5-30. Note that the fans are con-
nected to headers 1 and 2 by default.

Figure 5-30. Thermal Management EBK Fans

oMiNYIE TIYE
0804 VB OIAZL 30 |
21 §9Z0¥080 1300N

2. Configure jumper J9 to power the thermal management EBK using an external power supply, as
shown in Figure 5-31.
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Figure 5-31. External Power Supply Connected

5.4.2.2 Run Thermal Management System Firmware

54.2.2.1 CYS8CKIT-030 PSoC 3 DVK

The steps to run the example firmware on CY8CKIT-030 are:

1.

9.

Make the hardware connections on the CY8CKIT-030 DVK, as explained in 5.4.2.1.1 CY8CKIT-
030 PSoC 3 DVK.

Attach a USB cable from the PC to the PSoC 3 DVK program/debug USB port (use J1, the USB
connector closest to the corner of the board). Ensure that the TME EBK is not attached to the
PSoC 3 DVK before attaching the USB cable for programming.

Open the ThermalManagementSystem_030_050 project using PSoC Creator and select Debug
> Program to program the PSoC.

Detach the USB cable; if the DVK is powered by external power supply, disconnect power supply
to the DVK as well.

Connect the CY8CKIT-025 EBK and TME EBK to the DVK, as shown in Figure 5-20.
Power the PSoC 3 DVK and the TME EBK, as shown in Figure 5-20.

Press the Reset (SW1) button on the PSoC 3 DVK to run the newly programmed firmware
image.

On reset, the LCD displays a welcome message and starts with the Zone 1 temperature reading
and the corresponding temperature calculation algorithm. The desired and actual fan speeds cor-
responding to that zone are also displayed.

Use the push button SW2 to view the different zone characteristics.

5.4.2.2.2 CY8CKIT-001 PSoC DVK

The steps to run the example firmware on CY8CKIT-001 are:

1.

Make the hardware connections on the CY8CKIT-001 DVK, as explained in 5.4.2.1.2 CY8CKIT-
001 PSoC DVK.

. Apply 12-VDC power to the PSoC DVK.

Attach the MiniProg3 device, first to a USB port on the PC and then to the PROG port on the
CYB8CKIT-009 PSoC 3/CY8CKIT-010 PSoC 5LP processor module. Ensure that the TME EBK is
not attached to the PSoC 3 DVK before attaching the USB cable for programming.
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4. Open the ThermalManagementSystem_001 project using PSoC Creator and select Debug >
Program to program PSoC 3.

Detach the MiniProg3 and remove power supply to the PSoC DVK.

Connect the CY8CKIT-025 EBK and TME EBK to the PSoC DVK, as shown in Figure 5-21.
Power the PSoC DVK and TME EBK, as shown in Figure 5-21.

Press the Reset (SW4) button on the PSoC 3 DVK to run the newly programmed firmware
image.

9. On reset, the LCD displays a welcome message and starts with the Zone 1 temperature reading

and the corresponding temperature calculation algorithm. The desired and actual fan speeds cor-
responding to that zone are also displayed.

10.Use the push button SW1 to view the different zone characteristics.

® N oo

Testing the Project

In this project, the fan temperature is controlled based on the temperature of the corresponding ther-
mal zone. To test the closed loop speed control of Fan 3, vary the potentiometer on the DVK. This
simulates the condition of changing the corresponding zone temperature in the project. The speed of
Fan 3 is adjusted according to the temperature vs speed graph shown in Figure 5-32. To test the
closed loop speed control of Fan 4, touch the RTD sensor on the CY8CKIT-025 EBK. This results in
variations in the measured RTD temperature. The speed of Fan 4 is adjusted according to the tem-
perature vs speed graph shown in Figure 5-33.

On reset, the LCD displays the characteristics of Zone 1. These characteristics include the zone
temperature, temperature calculation algorithm, desired fan speed, and the actual fan speed. The
fan speeds will match the corresponding zone thermal profiles. Press the push button (SW1 on
CY8CKIT-001 or SW2 on CY8CKIT-030) once to view the characteristics of Zone 2. Press the push
button (SW1 on CY8CKIT-001 or SW2 on CY8CKIT-030) again to view the individual sensor temper-
atures for each zone and the weighted composite zone temperature. Pressing the button again will
repeat this display sequence.

Project Details

This project demonstrates how the temperature sensors in the CY8CKIT-025 EBK combined with
the fans on the TME EBK can create a complete thermal management system. The example shows
how to combine temperature readings from a number of temperature sensors in a variety of ways
and use the composite temperature to set desired fan speeds according to a customizable transfer
function.

The thermal management example uses the concept of a "Thermal Zone", which describes how to :
m combine multiple temperature sensor readings to form a composite zone temperature
m map the zone temperature to a fan speed

By this definition, each fan is controlled according to its own independent thermal zone. This exam-
ple has two thermal zones because the TME EBK has only two fans installed. Algorithms currently
implemented to combine multiple temperature sensors into a composite zone temperature include:
straight average, weighted average, and maximum.

In this example, the weighted method is used on both fans. A zone temperature-to-fan speed trans-
fer function is then definable for each zone. Linear and table driven transfer functions are currently
implemented. This example uses the table driven transfer function on both fans; that is, a look-up
table maps the composite zone temperature-to-fan speed.

This example is a simulation of a thermal management system. Zone 1, corresponding to Fan 3 in
Figure 5-32 combines temperature measurements from two temperature sensors (potentiometer
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temperature emulator and RTD). The potentiometer temperature emulator allows easy demonstra-
tion of fan control over a wide simulated temperature range without the need for an environmental
chamber to cycle through temperatures. In Zone 1, the temperature sensors are combined using a
weighted average where the potentiometer is given 90 percent weight and the RTD is given 10 per-
cent weight. Adjust the potentiometer (R20 on the CY8CKIT-001 DVK and R56 on the CY8CKIT-030
DVK) to vary the simulated temperature value in the approximate range of 15 °C to 100 °C. The
Zone 1 speed transfer function is table driven and follows the profile shown in Figure 5-32.

Figure 5-32. Thermal Management System Project - Zone1 Thermal Profile

Thermal Zone 1

Fanl Speed (RPM]

o
15 3% 55 75 -

Zone Temperature (C)
21=(9/10)* T1 - (1/10} * T2
Hysteresis = 4¢

Zone 2, corresponding to Fan 4 in Figure 5-33, consists of two temperature sensors and a single fan.
The Zone 2 speed transfer function is table driven and is shown in Figure 5-33. Note that the temper-
ature range is very narrow and close to room temperature. This is to allow simple testing at room by
touching a temperature sensor with a warm finger to cause a fan speed change. In Zone 2, the tem-
perature sensors are combined using a weighted average where the RTD is given 90 percent of the
weight and the diode is given 10 percent weight. In this example, the RTD temperature reading dom-
inates the overall zone temperature calculation.

Figure 5-33. Thermal Management System Project - Zone2 Thermal Profile

Thermal Zone 2
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9000
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54.3.1 Project Schematic
Figure 5-34 shows the PSoC Creator schematic of the project.
Figure 5-34. PSoC Creator Schematic

Connect PSoC Precision Analog Temperature Sensor Expansion Board Kit CY8CKIT-025 to PORT E on the PSoC 3 Development Kit CYSCKIT-030
Connect Thermal Management EBK CYBCKIT-036 toe PORT D on the PSoC 3 Development Kit CYSCKIT-030
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A four-channel ADC is used to measure the voltages across the RTD, diode, RTD/diode current cal-
ibration resistor, and potentiometer, which simulates an analog temperature sensor. IDAC is used to
provide the excitation currents for the diode, RTD, and calibration resistor. The closed loop fan con-
troller component senses and controls the fan speed.

Application notes AN60590 and AN70698 provide detailed explanations on temperature measure-
ment using diode and RTD, respectively. Application note AN66627 describes the fan controller
operation in detail.

5.4.3.2 Component Configuration

Figure 5-35 and Figure 5-36 show the FanController component configuration.
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Figure 5-35. FanController Component Configuration - Basic Tab

[ : - @ )
Configure 'FanController . p—y 2
Name:
Basic | Fans |~ Builtin 4Pk
Fan Control Method Merts
") Fimware (CPU) [7] Fan stall / Rotor lock
@ Hardware (UDB) [C] UDE speed regulation failure

Control loop period (sec): 0.16 =
Tolerance: 1% -
[ Acoustic noise reduction

Connections

[ Display as bus

[ Bdemal clock

The Fan Control Method is chosen as hardware (UDB), which means that the fan speed is controlled
using the hardware blocks inside PSoC without any CPU intervention. See the FanController com-
ponent datasheet in PSoC Creator for details on the other parameters.

Figure 5-36. FanController Component Configuration - Fans Tab

( Configure 'FanController' a -y l PR X )
Name: CLFC
Basic " Fans | Buitin 4 b
Motor support PWM output configuration
@ 4-pole motors Number of fans: 2 =

() &-pole motors PWM resolution: PWM frequency: | 25 kHz

Enter 2 datapaints (A, B) from duty cycle to RPM curve for each fansbank.
Fan number Initial RFM
Duty cycle A (%) RPM A Duty cycle B (%) RFM B
1 25 = 5800 5 75 = 106500 5000
2 25 = 5800 5 75 = 106500 5000

This tab provides the option to choose the number of fans and the speed to RPM mapping of each
fan. The individual fan parameters are configured, as shown in Figure 5-36. The configuration is
done based on the datasheet specifications of the fans used on the TME EBK.
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Figure 5-37 shows the ADC configuration to measure the potentiometer voltage. The +6.144 V volt-
age range is chosen because the potentiometer voltage can vary from 0 to VDDA. The Bypass Buf-
fer option is selected for the Buffer Mode parameter to measure voltage near the supply rails.

Figure 5-37. ADC Configuration for Potentiometer Voltage Measurement

Corfiguration name:
Modes

Conversion mode:

Resolution (bits):

Configure ‘ADC_DistSig" S [
Name:  [TSHREER
" Configl |~ Config2 " Common |~ Builtin 4 b
Comment Default Config

CFG1

ADC_DelSig_CFG1

16

-

[ Conversion rate (SPS):
Actual conv. rate (SPS)

Clock frequency {kHz):

10000 2 Range: 2000 - 48000 SPS
5869
640,000

Input options - Differential mode

Input range [H‘AG 144V { -Input +/- 6*Vref )

™

(| Buffer gain: |1

Input range:

o T T X T aoomv

Reference
Reference: [Intemal 1.024 Volis -
Vref (V) [1.024

| Alignment
@ Right Coherency = LOW
) Left 24 bits (OVF Protected)

ADC Range
(Bypass Buffer Mode)

Vssa *

6,,1,;10%@

Figure 5-38 shows the ADC configuration to measure voltage across the sensors (diode and RTD).
The Resolution parameter is set to 20 bits to perform high-resolution temperature measurements.

Figure 5-38. ADC Configuration for Temperature Sensor Measurement

r 5
Configure 'ADC_DelSig' -:— — "._ R ——— M

MName ADC_DelSig

Configl Conﬁgz] Common | Built-in

Commerit:

Configuration name:
Modes

Conversion mode:

Second Config
CFG2

ADC_DelSig_CFG2

Resolution (bits):

Il Conversion rate (SPS): 100 = Range: 8 - 187 SPS
Actual conv. rate (SPS). |98
Clock frequency (kHz): 1638.400

Input options - Differential mode

input range: [ +/-1.024V (nput =/~ Vief )

™

(| Buffer gain:
Buffermode: | Level Shit =

Reference

Reference: |Intemal 1.024 Volts

Vief (v):  [1024

Alignment

O Left Bit-23 (OVF Protected)

@ Right Coherency = LOW

Input range:

Vdda *
_~650 mV

ADC Range
(Level Shift Mode)

Vssa

6__}___‘10%”&
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Figure 5-39 shows the IDAC component configuration. The Polarity parameter of the IDAC is set to
the current sourcing mode and the Speed parameter is set to High Speed to have a faster settling
time for the IDAC output.

Figure 5-39. IDAC Configuration

Hardware Controlled

Range
0-31.875uA (1/8 uAsbit)

Configure TDACS [ 2 [t
Mame: DAC]
" Configure | Built-in q b
IDAC
Polarity Speed
@ Positive (Source) Low Speed
Negative (Sink) @ High Speed

Data Source
DAC Bus

@ CPUor DMA (Data Bus)

@ 0-255uA  (1uAvbit)
Strobe Mode
0-204mA  (BuAsbit) Bdemal
@ Register Write
Value
uA: 127 Hardware Enable
8bit Hex: 7F

Mote: Changing any valus
field recalculates the others

| Datasheet | [ oK ]

Cancel

5.4.3.3 Firmware Description and Flowchart

The thermal management system example consists of the main application and thermal manager.
The main application is responsible for the user interface and for periodically calling the thermal
manager. The application implementation is available in main.c and on the Test Application tab of the
project schematic. The thermal manager implementation is available in ThermalManager.c and on
the Thermal Manager tab of the project schematic.

The main application must call ThermalManager_Start() to initialize the thermal manager. Then it
must periodically call ServiceThermalManager() to run temperature and speed updates. In this
example, this is done every 500 ms but can be changed by modifying

#define THERMAL_ UPDATE_MS RATE in main.c.

All the parameters that define the zone composite temperature sensor algorithm and the zone tem-
perature-to-fan speed algorithm are defined in the beginning of ThermalManager.c. To modify these
settings, refer to ThermalManager.h for the relevant keywords.

The following flowchart shows the basic function of the thermal manager along with the APIs in Ther-
malManager.c that implement the main service loop.
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Figure 5-40. Thermal Manager Flowchart
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In this example, the LCD displays status information about thermal management system across
three screens. You can cycle through the status screens by pressing SW1 on the CY8CKIT-001 DVK
or SW2 on the CY8CKIT-030 DVK. The three screens are:

m Screen 1-Zone 1 Summary

This screen displays the current status of Zone 1. Line 1 displays the zone number, current com-
posite zone temperature, and the zone temperature calculation algorithm used. Line 2 displays
the desired fan speed and the actual fan speed for Zone 1.

Figure 5-41. Zone 1 Summary

Z1:T=16 WEIGHTED
Fi3:/4,5/0,0] |A3]:]451]5

m Screen 2 - Zone 2 Summary

This screen displays the current status of Zone 2. Line 1 displays the zone number, current com-
posite zone temperature, and the zone temperature calculation algorithm used. Line 2 displays
the desired fan speed and the actual fan speed for Zone 2.
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Figure 5-42. Zone 2 Summary

22 :T=26 WEIGHTED
F4 :7000 A4:7062

m Screen 3 - Temperature Sensors Summary

This screen displays the current temperature sensor readings for all sensors in the system. Line
1 displays the Zone 1 temperature sensor values. The temperature on the extreme left is the
zone's composite temperature followed by the temperatures of each contributing sensor. Line 2
displays the same information for Zone 2.

Figure 5-43. Temperature Sensors Summary
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A.2 Board Layout

A2A1 PDC-09802 Top

A22 PDC-09802 Bottom
I
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A.3 Bill of Materials (BOM)
Item | Qty.| Reference Value Description Manufacturer I BT (T
Number
1 PCB Cypress PDC-09802 Rev02
2 1 |J3 40 Pin Header CONN HEADER .100 DUAL R/A 40POs | Frotectron P9104-40-12-1
Electromech
3 1|42 Thermocople CONN OMEGA Thermocouple Type K | OMEGA PCC-SMP-K-5
Connector
THERMISTOR
4 1 | TH1 NTG 10K OHM 1% | THERMISTOR 10K OHM NTC 0603 | Murata NCP18XH103F03RB
5 1 |Ro 10K, 0.1% RES 10K OHM 1/8W .1% 0805 SMD | Panasonic - ECG | ERA-6AEB103V
6 1 |J4 8 PIN Connector | CONN TERM BLOCK T/H 8POS 3.5MM | Phoenix Contact | 1984675
. Terminal Blocks PT 1.5/2-3.5H 2POS .
7 3 J7, J8, J9 2 Pin Jumper HRZ 3.5mm SCREW Phoenix Contact | 1984617
8 2 |R7,R10 20E, 1% RES 20.0 OHM 1/8W 1% 0805 SMD | Vishay/Dale CRCWO080520ROFKEA
9 1 |RTD1 ;'%"P SENSOR | rEMp SENSOR RTD 100 OHM 0805 | Vishay/Beyschlag | PTS080501B100RP100
10 1 |R8 100E, 0.1% RES 100 OHM 1/8W 0.1% 0805 SMD | Panasonic - ECG | ERA-6AEB101V
11 1 |Je 2p_jumper CONN HEADER VERT SGL 2POS 3M 961102-6404-AR
GOLD
12 |2 |R3 R4 OE Resistor RES 0.0 OHM 1/8W 0805 SMD Panasonic - ECG | ERJ-6GEYOR0O0V
13 |1 |ut DS600U+ IC SENSOR TEMP 8-USOP Maxim Integrated | qa0(),
Products
14 1 |Re 330K, 1% RES 330K OHM 1/8W 1% 0805 SMD | Panasonic - ECG | ERJ-6ENF3303V
15 1 |R5 15K, 1% RES 1.50K OHM 1/8W 1% 0805 SMD | Panasonic - ECG | ERJ-6ENF1501V
16 |1 |5 3p_jumper CONNHEADER VERT SGL3POS | 3 961103-6404-AR
GOLD
No Load Components
17 (1 |TP1 RED TP TEST POINT PC MINI .040"D RED Keystone 5000
Electronics
18 |2 |TP2,TP3 BLACK TP TEST POINT PC MINI .040"D RED Keystone 5001
Electronics
19 |3 |TP4, TP5, TP6| PADS PADS
Special Jumper Installation Instructions
Install jumper Rectangular Connectors MINI JUMPER . ) .
20 |1 |6 across pins 1 and 2 | GF 13.5 CLOSE TYPE BLACK Kobiconn 151-8030-E
Install jumper Rectangular Connectors MINI JUMPER .
U S across pins 3 and 2 | GF 13.5 CLOSE TYPE BLACK Kobiconn 151-8030-E
Install as per Assembly drawing
22 | 3 | | | BUMPER CLEAR .500X.23" SQUARE | Richco Plastic Co | RBS-3R
A4 Regulatory Compliance Information

The CY8CKIT-025 PSoC Precision Analog Temperature Sensor Expansion Board has been tested
and verified to comply with the following electromagnetic compatibility (EMC) regulations.

m EN 55022:2010 Class A - Emissions
m EN 55024:2010 Class A - Immunity
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